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Contacting Veeam Software 
At Veeam Software we value the feedback from our customers. It is important not only to help you quickly with 
your technical issues, but it is our mission to listen to your input, and build products that incorporate your 
suggestions. 

Customer Support 
Should you have a technical concern, suggestion or question, please visit our Customer Center Portal at 
www.veeam.com/support.html to open a case, search our knowledge base, reference documentation, manage 
your license or obtain the latest product release.   

Company Contacts 
For the most up to date information about company contacts and offices location, please visit 
www.veeam.com/contacts.html. 

Online Support 
If you have any questions about Veeam products, you can use the following resources: 

 Full documentation set: www.veeam.com/documentation-guides-datasheets.html 

 Community forum at forums.veeam.com 

 

https://www.veeam.com/support.html
https://www.veeam.com/contacts.html
https://www.veeam.com/documentation-guides-datasheets.html
https://forums.veeam.com/
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About This Document 
This document provides general information on how to use the Veeam Backup for Microsoft Office 365 solution to 
back up and recover your Microsoft Online and On-Premises organizations data.  

Information herein is applicable to Veeam Backup for Microsoft Office 365 version 2.0 until it is replaced with a 
newer product version. 

Intended Audience  
This guide is intended for IT specialists who want to provide 24/7/365 data availability for Microsoft Online and 
On-Premises organization users. 

Revision History 

Revision # Date Change Summary 

Revision 1 7/24/2018 Initial version of the document for Veeam Backup for Microsoft Office 365 2.0. 
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About Veeam Backup for Microsoft 
Office 365 
Veeam Backup for Microsoft Office 365 is a comprehensive solution that allows you to back up and recover your 
Microsoft Office 365 and on-premises Exchange and SharePoint organizations data containing Microsoft Exchange 
items, Microsoft SharePoint items, and OneDrive documents. 

The solution can be deployed on virtual or physical machines, or directly on cloud platforms such as Azure or 
Amazon Web Services. 

To recover your data, you use Veeam Explorer for Microsoft Exchange or Veeam Explorer for Microsoft 
SharePoint both of which come as part of the Veeam Backup for Microsoft Office 365 distribution package. The 
Veeam Explorers set allows you to browse your backup content and perform necessary disaster-recovery 
operations. 

Not only can you recover your data, eliminating the risk of losing it, but you can also export required items, save 
them locally to your hard drive or over the network, or send via your email directly from the backup file, without 
having to extract the content. 

Veeam Backup for Microsoft Office 365 also gives service providers the abilities to back up tenants organizations 
data directly from the tenants servers by establishing the connection to tenants organizations and retrieving the 
existing data according to the rules you define. 
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What's New 
The following new features and enhancements have been implemented in Veeam Backup for Microsoft Office 365 
version 2.0: 

 Support for Microsoft SharePoint sites, libraries, items, and documents backup and restore. 

 Support for Microsoft OneDrive documents backup and restore. 

 Support for separate components installation during setup. 

 Support for selecting different color schemes. 

 Support for custom list templates in Veeam Explorer for Microsoft SharePoint. 

 Support for comparing items with Veeam Explorer for Microsoft Exchange. 

 Support for exporting extended logs for proxy and controller components. 
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How Veeam Backup for Microsoft 
Office 365 Works 
The following steps briefly describe the overall concept of Veeam Backup for Microsoft Office 365 backup and 
restore procedures: 

1. To be able to back up your Microsoft Office 365 and/or On-Premises SharePoint/On-Premises Exchange 
organizations data, you add these organizations to the program scope. 

For more information on adding new organizations, see Adding Microsoft Organizations. 

2. To process your data more efficiently, you configure additional backup proxy servers to govern 
ingress/egress requests, and assign new backup repositories to store your backup data.  

For more information on configuring backup proxy servers along with the backup repositories, see 
Configuring Backup Proxy Servers and Configuring Backup Repositories respectively. 

3. To create a new backup file, you configure a backup job that defines the behavior of how your 
organizational data should be archived. 

For more information on creating and configuring new backup jobs, see Performing Organization Data 
Backup. 

4. To explore, recover, export, save or send your backup data, you utilize the capabilities of Veeam 
Explorers. 

For more information, see Exploring Veeam Backup for Microsoft Office 365 Backups. 
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Applications and Components 
Veeam Backup for Microsoft Office 365 distribution package comprises the following applications: 

 Veeam Backup for Microsoft Office 365 

 Veeam Explorer for Microsoft Exchange 

 Veeam Explorer for Microsoft SharePoint 

Veeam Backup for Microsoft Office 365 
Veeam Backup for Microsoft Office 365 is responsible for handling an organization data backup and consists of 
the following components: 

 Veeam.Archiver.Service service. Controls global configuration settings. 

 Veeam.Archiver.Proxy service. Responsible for proxy servers management. 

 Veeam.Archiver.Shell UI component. Provides a graphical UI representation. 

 Veeam.Archiver.RESTful.Service service. Processes RESTful commands. This service is disabled 
by default and can be activated by enabling the REST feature, as described in the Configuring RESTful 
API Settings section. 

Veeam Explorer for Microsoft Exchange 
Veeam Explorer for Microsoft Exchange allows you to explore and recover your Microsoft Exchange data from the 
backups created with Veeam Backup for Microsoft Office 365. 

Veeam Explorer for Microsoft SharePoint 
Veeam Explorer for Microsoft SharePoint allows you to explore and recover your Microsoft SharePoint and 
Microsoft OneDrive data from the backups created with Veeam Backup for Microsoft Office 365. 

NOTE: 

Veeam Explorer for Microsoft SharePoint and Veeam Explorer for Microsoft OneDrive for Business are 
distributed in one package. 
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Understanding Repository Files 
Backup repositories are used to store your backup data archived with Veeam Backup for Office 365. 

After you install the solution, Veeam creates the default backup repository which is the C:\VeeamRepository 
directory on your localhost. You are encouraged to configure additional repositories to enhance overall 
production environment performance.  

Direct Access Storage is a recommended type for storing your backup data. Others are SAN and SMB3 (with 
experimental support). For more information on configuring new backup repositories, see Configuring Backup 
Repositories. 

The repository structure consists of various subfolders that are organized and named based on the last items 
modification time. For example, an item that was last modified on 26 May 2015 will be backed up to the 
subfolder 2015, all items last modified in 2016 — to the subfolder 2016 and so on. 

When you run a backup job for the first time, Veeam creates the following set of files: 

 The Repository.xml file that stores overall configuration settings, including proxy and management 
servers IDs. 

 The repository.adb file, which is the database file that keeps your Office 365 organizations data. 
Such data is kept according to the retention policy. For details, see Understanding Retention Policy. 

 Checkpoint and transaction logs that are required when performing log replay to apply the specific state 
when recovering your databases. 

 

NOTE: 

If you map several backup jobs to the same backup repository, the backup data will be merged into a single 
repository.adb files. 
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Understanding Configuration Database 
Veeam Backup for Microsoft Office 365 uses a configuration database to store general application settings for the 
management server and the corresponding backup proxy servers. 

The database is located in the C:\ProgramData\Veeam\Backup365\ConfigDB directory on a management 
server. 

Partial configuration data is periodically replicated to the proxy servers configuration database located in the 
C:\ProgramData\Veeam\Backup365\ProxyDb directory on a proxy machine. Proxy settings are stored in 
the Proxy.xml file in the same folder. 
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Planning and Preparation 
This section provides details on how to prepare your environment before start using Veeam Backup for Microsoft 
Office 365. 

To learn more, see the following topics: 

 System Requirements 

 Used Ports 

 Required Permissions 

 Considerations and Limitations 

 User Authentication 
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System Requirements 
This section lists system requirements for Veeam Backup for Microsoft Office 365. 

Supported Microsoft Exchange Organizations 

Requirement Specification Comments 

Exchange Organization Microsoft Office 365 Exchange Online For more information on system requirements 
and limitations for Office 365, see this Microsoft 
article. 

Microsoft Exchange 2016 or 2013 (on-
premises) 

For more information on limitations on backup 
and restore of mail items, see the Considerations 
and Limitations section. 

NOTE: 

Throttling policies for Exchange Online cannot be managed via the Office 365 interface. For that, contact 
Microsoft technical support. 

Supported Microsoft SharePoint Organizations 

Requirement Specification Comments 

SharePoint Organization Microsoft Office 365 SharePoint Online For more information on system requirements 
and limitations for Office 365, see this Microsoft 
article. 

Microsoft SharePoint 2016 For more information on hardware and software 
requirements for SharePoint 2016, see this 
Microsoft article. 

https://products.office.com/en-us/office-system-requirements/#Office365forBEG
https://products.office.com/en-us/office-system-requirements/#Office365forBEG
https://products.office.com/en-us/office-system-requirements/#Office365forBEG
https://products.office.com/en-us/office-system-requirements/#Office365forBEG
https://docs.microsoft.com/en-us/sharepoint/install/hardware-and-software-requirements
https://docs.microsoft.com/en-us/sharepoint/install/hardware-and-software-requirements
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Veeam Backup for Microsoft Office 365 Server 

Specification Requirement 

Hardware 
 CPU: any modern multi-core x64 processor, 4 cores minimum. 
 Memory: 8 GB RAM minimum. Additional RAM and CPU resources improve 

backup, restore and search performance. 
 Disk Space: 500 MB for product installation and additional free space for 

configuration database (depending on the amount of organizations, jobs and 
sessions) and product logs. 

OS Only 64-bit version of the following operating systems are supported: 

 Microsoft Windows Server 2016 
 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 SP1 
 Microsoft Windows 10 
 Microsoft Windows 8.x 
 Microsoft Windows 7 SP1 

Software 
 
 Microsoft .NET Framework 4.5.2 or later. 
 Windows C Runtime and Update (UCRT) in Windows. For more information, 

see  this Microsoft article. 
 Mail restore requires Veeam Explorer for Microsoft Exchange 9.6. 
 To use PowerShell cmdlets for backup and/or restore, Windows PowerShell 

2.0 or higher is required. When using Windows 2012 or 2012R2, Windows 
PowerShell 2.0 Engine must be installed regardless of the current PowerShell 
version. 

 For more information on Microsoft Office 365 system requirements and 
limitations, see this Microsoft article. 

 Mail backup is supported for Microsoft Exchange 2016 or 2013. 

IMPORTANT! 
 When you install Veeam Explorer for Microsoft Exchange, Veeam Explorer for Microsoft SharePoint, 

and Veeam Backup for Microsoft Office 365 on different servers, the OS version on computers with 
Veeam Explorers must be the same or higher than the OS version on a computer with Veeam 
Backup for Microsoft Office 365. 

 Veeam Explorers can only be installed on a machine hosting Veeam Backup for Microsoft Office 365 
2.0 or the Veeam Backup for Microsoft Office 365 Console component. You can also 
use a machine with Veeam Backup & Replication 9.5 Update 3 (or higher) that is deployed either 
along with any of the above components, or as an independent solution. 

 For Microsoft Outlook 2016 the preliminary releases, like Insider releases, or releases provided 
through Monthly Channel Updates are not supported; Veeam supports only RTM/GA versions of this 
product. For more information, see this Microsoft article. 

 When using BETA version of the program, you can only use the set of Veeam Explorers that come 
with the BETA distribution package. 

https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows
https://products.office.com/en-us/office-system-requirements/#Office365forBEG
https://products.office.com/en-us/office-insider?tab=Windows-Desktop%20and%20https://support.office.com/en-us/article/Overview-of-update-channels-for-Office-365-ProPlus-9ccf0f13-28ff-4975-9bd2-7e4ea2fefef4?ui=en-US&rs=en-US&ad=US
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Backup Proxy Server 
Backup proxy server can be a physical or a virtual machine running Microsoft Windows operating system. For 
more information on configuring backup proxy servers, see Configuring Backup Proxy Servers. 

IMPORTANT! 

Backup proxy servers and the machine hosting Veeam Backup for Microsoft Office 365 must be deployed 
within the same or a trusted domain. 

Specification Requirement 

Hardware 
 CPU: any modern x64 processor, 4 cores minimum. 
 Memory: 8 GB RAM minimum. Additional RAM and CPU resources improve 

backup, restore and search performance. 
 Disk space: 300 MB for backup proxy installation and additional free space for 

configuration database (depending on the amount of organizations, jobs and 
sessions) and backup proxy logs. 

OS Only 64-bit version of the following operating systems are supported: 

 Microsoft Windows Server 2016 
 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 SP1 
 Microsoft Windows 10 
 Microsoft Windows 8.x 
 Microsoft Windows 7 SP1 

Proxy servers can be deployed on the following core editions: 

 Microsoft Windows Server 2016 LTSC, 1709 
 Microsoft Windows Server 2012 R2 

Other 
 Microsoft .NET Framework 4.5.2 or higher. 
 Windows C Runtime and Update (UCRT) in Windows. For more information, 

see  this Microsoft article. 

https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows
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Used Ports 
The following table contains network ports that must be opened to handle ingress/egress requests from/to 
various system components of Veeam Backup for Microsoft Office 365.  

From To Protocol Port Notes 

Veeam Backup for 
Microsoft Office 365 
server 

Microsoft Exchange 
Online 

TCP 80, 443, 
optionally 587 

Used for connection to Microsoft 
Exchange Online organizations. 

If you plan to use Exchange Online as 
a mail server for sending 
notifications, then open the port 587. 

Microsoft SharePoint 
Online 

TCP 80, 443 Used for connection to Microsoft 
SharePoint Online organizations. 

Microsoft SharePoint On-
Premises 

HTTP (HTTPS) 5985 (5986) Used for connection to Microsoft 
SharePoint On-Premises organizations 
using the WinRM port. 

Backup proxy server TCP 9193 This port must be opened on the 
backup proxy server for data 
communication with the Veeam 
Backup for Office 365 server. 

Veeam auto-update 
server 

HTTPS 443 Used to access the auto-update 
server and the licensing server. For 
more information, see Checking for 
Updates and Installing License. 

The endpoint URL for both servers is 
https://autolk.veeam.com/json-
rpc.php. 

Clients Veeam Backup for 
Microsoft Office 365 
management server 

TCP 9191 Open this port on the Veeam Backup 
for Office 365 management server for 
data communication between the 
server and its clients: RESTful API, 
PowerShell and Veeam.Archiver.Shell 
(UI), and, optionally, connection to 
remote management server (if any). 

Veeam Explorer for 
Microsoft Exchange 
and Veeam Explorer 
for Microsoft 
SharePoint 

Veeam Backup for 
Microsoft Office 365 
management server 

TCP 9194 Open this port on the Veeam Backup 
for Office 365 management server for 
data communication between solution 
components, as well as for Veeam 
Explorer for Microsoft Exchange and  
Veeam Explorer for Microsoft 
SharePoint clients (RESTful API and 
PowerShell). 

https://autolk.veeam.com/json-rpc.php
https://autolk.veeam.com/json-rpc.php


 

20 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Backup proxy server Veeam Backup for 
Microsoft Office 365 
management server 

TCP 9191 This port must be opened on the 
Veeam Backup for Office 365 
management server for data 
communication with backup proxy. 

This port can be changed according 
to the Editing Backup Proxy Server 
section. 

Microsoft Exchange 
Online 

TCP 80, 443 These ports are used for connection 
to Microsoft Exchange Online using 
EWS (Exchange Web Services). 
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Required Permissions 
This section describes required permissions for user accounts that are going to be used to back up and recover 
your data. 

For Backup 

Required Permissions for Veeam Backup for Microsoft Office 365 
By default, Veeam Backup for Microsoft Office 365 (Veeam Backup for Microsoft Office 365 
Service) uses the Local System account. This account has administrative rights on the local machine and 
should not be changed for Veeam services. 

Required Permissions for SharePoint Organizations 
The account that is used to connect to Microsoft SharePoint organizations (On-Premises or Online) must belong 
to that organization and must conform to the following: 

 For SharePoint On-Premises. 

The account must be a member of the Farm Administrator group and must have the Site Collection 
Administrator role. This role can be assigned either automatically, when adding a new SharePoint 
organization, or manually. For more information on adding new organizations, see Adding Microsoft 
Organizations. 

 For SharePoint Online.  

The account must have either the Global Administrator role, or the SharePoint Administrator role. 

If you prefer to use PowerShell to assign the SharePoint Administrator role for SharePoint Online 
organizations, you can use the following code snippet. 

Connect-MsolService  

$role=Get-MsolRole -RoleName "SharePoint Service Administrator"  

$accountname=UPN  

Add-MsolRoleMember -RoleMemberEmailAddress $accountname -RoleName $role.Name  

The MSOL module can be downloaded here. 

The $accountname parameter must be a user's UPN (for example, user.name@domain.com). 

Once the SharePoint Administrator role is assigned, wait for 10-15 minutes until you can back up your data. 

https://docs.microsoft.com/en-us/powershell/azure/active-directory/overview?view=azureadps-1.0
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Required Permissions for Exchange Organizations 
The account that is used to connect to Microsoft Exchange organizations (On-Premises or Online) must belong to 
that organization. Having a mailbox in that organization is optional.  

This account must have the following Exchange roles: 

 Role Management role. To grant ApplicationImpersonation role. 

 ApplicationImpersonation role. To allow this role assignment, the account must be granted the 
Organization Management permission. 

 Organizations Configuration role. To manage role assignments. 

 View-Only Configuration role. To obtain the necessary organization configuration parameters. 

 View-Only Recipients role. To view mailbox recipients (required for job creation). 

The ApplicationImpersonation role can be assigned by using any of the following methods: 

 Automatically, when adding Exchange organizations. 

 Manually, by using Exchange Management PowerShell cmdlets. 

 Using the Microsoft Exchange control panel. 

If you plan to use email notifications on backup job results, the mailbox address that will be used as a notification 
sender must be delegated the rights to connect to the SMTP server. See Configuring Notification Settings. 

NOTE: 

If you have created a new Exchange online organization, you may need to use the Exchange control panel or 
PowerShell cmdlet (Enable-OrganizationCustomization) to allow the ApplicationImpersonation role to 
perform any modifications and assignments. For more information, see this Microsoft article. 

Assigning ApplicationImpersonation Role via PowerShell 

For Microsoft On-Premises Organizations 
To assign the ApplicationImpersonation role for On-Premises organizations using PowerShell, do the 
following: 

1. Connect to the Exchange server. 

$UserCredential = Get-Credential 

$Session = New-PSSession -ConfigurationName Microsoft.Exchange -ConnectionUri 
http://exchangeServerName/PowerShell/ -Authentication Kerberos -Credential 
$UserCredential 

Import-PSSession $Session 

2. Use the following cmdlet to grant the role. 

New-ManagementRoleAssignment –Role ApplicationImpersonation –User "Administrator" 

https://technet.microsoft.com/en-us/library/jj200665(v=exchg.160).aspx
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For Microsoft Online Organizations 
To assign the ApplicationImpersonation role for Online organizations using PowerShell, do the following: 

1. Connect to the Exchange server. 

$Session = New-PSSession -ConfigurationName Microsoft.Exchange -ConnectionUri  

https://outlook.office365.com/powershell-liveid/ -Credential $Credential  -
Authentication Basic -AllowRedirection  

Import-PSSession $Session 

To obtain the list of users whom the ApplicationImpersonation role has already been granted, use the 
following cmdlet (for both On-Premises and Online organizations). 

Get-ManagementRoleAssignment -Role "ApplicationImpersonation" 

To remove the role, use the following cmdlet (for both On-Premises and Online organizations). 

Get-ManagementRoleAssignment -RoleAssignee "Administrator" -Role 
ApplicationImpersonation -RoleAssigneeType user | Remove-ManagementRoleAssignment 

For Restore 
 To be able to connect to the Veeam Backup for Microsoft Office 365 server from Veeam Explorers, you 

must use the account that belongs to the local Administrator group. 

 To automatically resolve mailboxes in Veeam Explorer for Microsoft Exchange and filter out Exchange 
System Mailboxes, you must configure your account according to the following: 

o This account can be included in the domain Administrators or Organization Management 
group. 

o This account can be granted Read permission for the objectClass attribute of the Microsoft 
Exchange System Object container. Make sure to select the Apply these permissions to 
objects and/or containers within this container only option.  

If the Read permission was not granted for the account that is a member of the 
Authenticated users group, Veeam Explorer will not be able to recover Exchange system 
mailbox objects. It is recommended to avoid processing such mailboxes by deselecting them in 
the backup job wizard. 

 The account you are using for restoring data to a public folder should own a mailbox on the target 
Microsoft Exchange server. 

 To restore folders/items back to Exchange Online organizations, the account you specify in the restore 
wizard requires sufficient permissions to access the target production server. To restore to the on-
premises Microsoft Exchange organization, the account you specify in the restore wizard will need the 
corresponding access rights: 

o If you plan to use the account that owns a mailbox on target, make sure it has Full Access. 
Full Access can be granted, for example, through impersonation or via rights assignment with 
the following cmdlet: 
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Add-MailboxPermission –Identity “<target_mailbox>” -User “<user_account>” -
AccessRights FullAccess –InheritanceType All 

o If you plan to use the account that does not own a mailbox on the target server (for example, a 
service account), then access rights for the target mailbox should be granted through Exchange 
impersonation. For example, you can run the following cmdlet: 

New-ManagementRoleAssignment -Name "<role_name>" -Role ApplicationImpersonation -User 
"<user_account>" [-CustomRecipientScope "<scope>"] 

The following cmdlet demonstrates how to narrow the group of users whom will be assigned appropriate roles to 
access the target mailbox. The CustomRecipientScope parameter is used with sample Organizational Unit 
specified as the scope: 

New-ManagementRoleAssignment -Name "Exchange Test" -Role ApplicationImpersonation -
User "Test User" -CustomRecipientScope "spain.local/TargetUsers" 

Recalling Privileges Granted Through Impersonation 
When finished working with Veeam Backup for Microsoft Office 365, you may want to recall the privileges 
assigned to the user through impersonation. For that, run the following cmdlet: 

Remove-ManagementRoleAssignment -Name "<role_name>" 
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Considerations and Limitations 
This section covers known Veeam Backup for Microsoft Office 365 considerations and limitations. 

Infrastructure and Configuration 
 Installing the product on Windows 2008 operating system is not supported; Windows 2008 R2 SP1 is a 

minimal supported OS version. 

 Using FAT32 is not recommended due to the limited database size, which is 4GB. Use NTFS and ReFS 
instead. 

 Requirements and limitations from Microsoft can be found in the System requirements for Office article. 
In particular, it is impossible to modify throttling policies for Exchange Online. If you need to modify 
these settings, please contact Microsoft technical support.  

 For Microsoft Outlook 2016, the preliminary releases, like Insider releases, or releases provided through 
Monthly Channel Updates are not supported; Veeam supports only RTM/GA versions of this product. For 
more information, see this Microsoft article. 

 Backup proxy servers and the Veeam Backup for Microsoft Office 365 server must be deployed within the 
same or trusted domain. 

 If you want to use HTTP proxies to connect to EWS for data retrieval, it is strongly recommended that 
you contact Veeam technical support to help you configure required parameters properly. 

 Current version does not support automatic firewall rules creation and ports opening. If any of the 
required ports is closed, you should open it manually. For more information, see Used Ports. 

 If you are running Veeam Backup for Office 365 UI (shell) and management server on different 
machines, before installing a backup proxy that will be controlled by that management server, make sure 
that management server is trusted for delegation. For more information, see this Microsoft article. 

 Symbolic link set as a mapped drive is not supported as repository target in this version. 

 If a Windows machine hosting backup proxy was renamed, this proxy will have the Offline status 
displayed in the management console. To work around, in the management console remove this proxy 
from the infrastructure configuration, then configure this proxy anew, targeting at the machine with its 
new name. Associated repositories will be preserved. 

 If the ProxyDB folder containing proxy configuration database is deleted from a proxy server, this proxy 
cannot obtain information about its associated repositories any longer. Thus, backup jobs targeted at 
those repositories will fail with the following error message: “Error: Repository does not exist.” To work 
around, you need to re-create this proxy. 

 A repository initially associated with the certain backup proxy can be used only by a proxy with the same 
or higher version of Windows OS. If you try to associate this repository with a backup proxy running an 
earlier Windows version (for example, after downgrading the proxy server OS due to maintenance 
reasons), the program will not be able to access the repository data. The error message will be issued 
saying: 
"Error: JetError -514, JET_errBadLogVersion, Version of log file is not compatible with Jet version".  
The reason is that Jet engine (ESE) differs for different versions of Windows OS. To be able to work with 
the data backed up by a proxy prior to such maintenance, make sure that the proxy has the same OS 
version before and after maintenance. 

 IPv6 addressing is not supported for Microsoft Azure China region. 

 Notifications on job results may not work properly for Microsoft Azure China and Germany regions. 

https://products.office.com/en-us/office-system-requirements/#Office365forBEG
https://docs.microsoft.com/en-us/DeployOffice/overview-of-update-channels-for-office-365-proplus?ui=en-US&rs=en-US&ad=US
https://docs.microsoft.com/en-us/microsoft-desktop-optimization-pack/appv-v4/how-to-configure-the-server-to-be-trusted-for-delegation
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Backup 
 Backup of In-Place Hold Items is not supported for on-premises Exchange 2013 due to EWS limitations.  

 When creating public folders backups, only the primary hierarchy mailbox will be selectable for the 
backup. 

 If you modify the retention policy tag for a folder, Veeam Backup will perform full synchronization of that 
folder during the next job run. The reason is that any change to retention policy makes changes to all 
items in the folder (modifies tag, updates last modification time). Such changes are treated by 
synchronization mechanism as the new item version, which, in turn, automatically initiates a full sync. 
For more information, see this Microsoft article. 

Restore 
 Bulk restore (restore of multiple objects) is not supported for public folders. Use usual (per-object) 

restore instead. 

 If you want to restore In-Place Hold Items or Litigation Hold Items to the original location (that is, 
original mailbox system folders), consider the limitations that exist for this kind of restore: 

o Restore of In-Place Hold Items is not supported for on-premises Exchange Server 2013 due to 
EWS limitations.  

o To restore In-Place Hold Items of Exchange 2016 mailboxes, these mailboxes must have In-
Place Hold enabled and applied at least once, with DiscoveryHolds system folder creation. 
Otherwise, restore of In-Place Hold Items will fail with an error: "Failed to restore In-Place Hold 
Items. Restore of In-Place Hold Items into Exchange 2013 is not supported". For information on 
enabling In-Place Hold and Litigation Hold, see this Microsoft article 

o Currently, Veeam Explorer for Microsoft Exchange does not support browsing and restoring 
items from the Versions subfolder of the Recoverable Items folder used by In-Place Hold and 
Litigation Hold to preserve items.  

https://technet.microsoft.com/en-us/library/dd297955(v=exchg.160).aspx
https://technet.microsoft.com/en-us/library/ff637980(v=exchg.160).aspx
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User Authentication 
Veeam Backup for Microsoft Office 365 uses the following components to connect to Microsoft Exchange and 
Microsoft SharePoint organizations and pass the authentication routine: 

 Exchange Web Services (EWS) and PowerShell to connect to On-Premises Microsoft Exchange 
organizations. 

 SharePoint Client Object Model (CSOM) and Windows Remote Management to connect to On-Premises 
Microsoft SharePoint organizations. 

 Microsoft Graph for Microsoft Office 365 organizations. 

Authentication for SharePoint Organization 
To be able to connect to On-Premises SharePoint organizations, you must configure Windows Remote 
Management. For more information, see this Microsoft article.  

You will be required to provide a WinRM port number when connecting to Microsoft SharePoint organizations. For 
more information, see Adding Microsoft On-premises SharePoint Organization. 

Authentication for Exchange Organization 

Using Exchange Web Services (EWS) 
When transferring data using EWS, the SSL connection is always established. 

Using PowerShell 
When transferring data using PowerShell, two methods are possible: 

 Use SSL w ith Basic authentication. This method is recommended by Microsoft as it provides secure 
communication of user credentials (account and password) inside the encrypted SSL channel. For more 
information. see Connect to Exchange Online PowerShell. 

$Session = New-PSSession -ConfigurationName Microsoft.Exchange -ConnectionUri 
https://outlook.office365.com/powershell-liveid/ -Credential $UserCredential -
Authentication Basic -AllowRedirection 

 Use SPN (Service Principal Name) and Kerberos authentication. To use this method, it is 
recommended to deploy Veeam Backup for Office 365 management server within the same domain as 
the Exchange server and provide access to the domain controller. You may also need to map the 
Exchange server to the hybrid domain. Consider that this method cannot be used for multiple servers 
included in CAS. 

Use the setspn command-line utility to map the Kerberos service principal name to the Microsoft 
account. For more information, see this Microsoft article. 

 setspn -A HTTP/Mail.hybridDomain.com ExchangeHost 

https://msdn.microsoft.com/en-us/library/aa384372(v=vs.85).aspx
https://technet.microsoft.com/en-us/library/jj984289%28v=exchg.160%29.aspx?f=255&MSPPError=-2147217396
https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2012-R2-and-2012/cc731241(v=ws.11)
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Licensing and License Types 
Veeam Backup for Microsoft Office 365 is licensed per user account in all organizations. 

Each user account consists of the following objects: 

 A personal mailbox. 

 An online Archive mailbox. 

 OneDrive documents. 

 Personal SharePoint sites. 

A license is not required for shared and resource mailboxes. 

Veeam also considers managed mailboxes that have at least one restore point that was created within the last 31 
days. If you do not archive a mailbox for 31 days, its license will be revoked and can be applied to another 
mailbox. 

NOTE: 

After you install Veeam Backup for Microsoft Office 365, you will be prompted to provide the product license. 
You can dismiss this step and continue using the product without any license installed. In this case, you will 
have the Community Edition mode that allows you to process up to 10 user accounts in all organizations 
including 1TB of Microsoft SharePoint data. Such mode suggests using the community license, which is not 
limited in time, nor implies any limitations in terms of program functionality. See Installing License. 

Grace Period  
To ensure a smooth license update and provide sufficient time to install a new license file, Veeam offers a grace 
period. A grace period is a period of time during which the product keeps working in a full-version mode after the 
license has expired or the number of mailboxes exceeds the number covered by the license.  

License Types 
Veeam Backup for Microsoft Office 365 supports the following types of licenses: 

 Subscription License. Paid, fully-functional license that expires at the end of the subscription term which 
is 1 or 3 years from the contract start date (depending on the subscription length). 

 Rental License. Paid, fully-functional license that expires at the end of the contract which is the last day 
of the month and normally 1 month from the contract start date. This license type is distributed only to 
service providers. 

 Not For Resale License. Free, fully-functional license that can be used for product demonstration, training 
and education. This license is not for resale or other commercial use. 

 Evaluation License. Free, fully-functional license that can be used for evaluation and testing purposes 
only. 
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Subscription License 
Subscription license is a paid and fully-functional license that expires at the end of the subscription term which is 
1 or 3 years from the contract start date (depending on the subscription length). 

License Expired 
Grace period of 1 month granted after the expiration of license for purpose of renewal. During this period, the 
program functionality is not limited by any means. After this period, processing of all user accounts in all 
organizations will be stopped; scheduled jobs will be terminated with failure. In both cases, a notification 
message will be shown to notify you that your license is either about to be expired or has expired. 

The restore abilities will continue to function regardless of whether your license has expired or not. 

License Exceeded 
Additional process of no more than 10 user accounts or 10% of the license count (whichever is greater) granted 
if your subscription license has exceeded its limit by up to 10 user accounts or up to 10% of the license count. 

If exceeded by more than 10 user accounts or more than 10% of the license count (whichever is greater), you 
can process these 10 (or 10%) extra user accounts according to the FIFO queue logic (that is, "first in - first 
out"); no more additional accounts are allowed. 

The grace period in this case equals 1 months. After this period, processing of excessive user accounts (in FIFO 
queue) will be stopped; no more extra accounts will be queued for processing. The corresponding messages will 
be displayed in the UI and written to the log.  

The restore abilities will continue to function regardless of the grace period state. 
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Rental License 
Paid, fully-functional license that expires at the end of the contract which is the last day of the month and 
normally 1 month from the contract start date. This license type is distributed only to service providers. 

License Expired 
Grace period of 1 month granted after the expiration of license for purpose of renewal. During this period, the 
program functionality is not limited by any means. After this period, processing of all user accounts in all 
organizations will be stopped; scheduled jobs will be terminated with failure. In both cases, a notification 
message will be shown to notify you that your license is either about to be expired or has expired. 

The restore abilities will continue to function regardless of whether your license has expired or not. 

License Exceeded 
Additional process of no more than 10 user accounts or 10% of the license count (whichever is greater) granted 
if your rental license has exceeded its limit by up to 10 user accounts or up to 10% of the license count. 

If exceeded by more than 20 user accounts or more than 20% of the license count (whichever is greater), you 
can process these 20 (or 20%) extra user accounts according to the FIFO queue logic (that is, "first in - first 
out"); no more additional accounts are allowed. 

The grace period in this case equals 2 months. After this period, processing of excessive user accounts (in FIFO 
queue) will be stopped; no more extra accounts will be queued for processing. The corresponding messages will 
be displayed in the UI and written to the log.  

The restore abilities will continue to function regardless of the grace period state. 
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Understanding Monthly Usage Report 
The rental license allows you to submit a monthly usage report starting from the first day of the month. Such 
reports contain information on all processed user accounts per each Office 365 organization added to the 
application scope. 

On the first day of each month and for the next nine days you will be receiving a notification message similar to 
the below one. 

 

You can send the report immediately by clicking the Send button or, you can skip this step by clicking 
Postpone. 

In the latter case, on each launch of the application the above message will continue to show for the next nine 
days. After this period, you will not be able to send a monthly report using the functionality described herein, but 
you can still view your reports as Veeam automatically saves them to the 
%programdata%\Veeam\Backup365\Reports directory in the PDF format. 

Reviewing and Managing Report 
To review details of a report, click Review. 

By default, Veeam shows all user accounts that were processed by all backup jobs for all organizations. You can 
select an organization by using the drop-down list at the top-left corner to view the accounts for the selected 
organization only. You can also use the search field at the top-right corner to find particular objects. 

To prevent certain accounts from being added to the report, select such accounts and click Remove, then, 
provide the removal reason and click OK. To undo removing, click Reset. 
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Saving Report 
You can save your report as a PDF file. For that, click Save As. The content of a PDF file will be similar to the 
figure below. 
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Not For Resale License 
Not For Resale (NFR) license is a free, fully-functional license that can be used for product demonstration, 
training, and education. 

License Expired 
Within a month before the expiration date, you will be receiving a notification message stating that your license 
is about to be expired. During this period, the program functionality will not be limited by any means. After your 
license has expired, processing of all user accounts will be stopped. 

The restore abilities will continue to function regardless of whether your license has expired or not. 

License Exceeded 
Processing of user accounts that exceed the allowed license count is not possible. 
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Evaluation License 
The evaluation license is a free and fully-functional license that can be used for evaluation and testing purposes 
only. 

License Expired 
Within a month before the expiration date, you will be receiving a notification message stating that your license 
is about to be expired. During this period, the program functionality will not be limited by any means. After your 
license has expired, processing of all user accounts will be stopped. 

The restore abilities will continue to function regardless of whether your license has expired or not. 

License Exceeded 
Processing of user accounts that exceed the allowed license count is not possible. 
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Deployment 
You can download Veeam Backup for Microsoft Office 365 installation package from the official Veeam website. 

The installation package contains the following installation packages: 

 Veeam Backup for Microsoft Office 365 

 Veeam Explorer for Microsoft Exchange 

 Veeam Explorer for Microsoft SharePoint 

If you want to use Veeam Backup for Microsoft Office 365 in a hybrid Exchange deployment or in the On-
Premises organization and plan to use SPN and Kerberos authentication, it is recommended that you install 
Veeam Backup for Office 365 within the same domain where an Exchange server is deployed and provide the 
access to the domain controller. 

IMPORTANT!! 

If you have been participating in the public beta testing program for Veeam Backup for Microsoft Office 365, 
be sure to uninstall the pre-release versions of Veeam Backup for Microsoft Office 365, Veeam Explorer for 
Microsoft Exchange, and Veeam Explorer for Microsoft SharePoint. Also, delete the content of the archive 
repository folder along with the C:\ProgramData\Veeam\Backup365 directory. For more information, see 
Removing Beta Version. 

https://www.veeam.com/backup-microsoft-office-365.html
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Installing Veeam Backup for Microsoft 
Office 365 
To install Veeam Backup for Microsoft Office 365, do the following: 

1. Open the folder with the Veeam Backup for Microsoft Office 365 distribution package. 

2. Run the Veeam Backup for Microsoft Office 365 setup file. 

 

3. Read and accept License Agreement. 

 

4. Select which components you want to install. For example, you may have each component to be installed 
on a different server.  

By default, Veeam Backup for Microsoft Office 365 will be installed to the C:\Program 
Files\Veeam\Backup365\ directory. To install to a different location, click Browse and specify the 
destination folder. 



 

37 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

 

5. Click Next and then click Install. 
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Installing Veeam Explorer for Microsoft 
Exchange 
To install Veeam Explorer for Microsoft Exchange, do the following: 

1. Open the folder with the Veeam Backup for Microsoft Office 365 distribution package. 

2. Run the Veeam Explorer for Microsoft Exchange setup file. 

 

3. Read and accept License Agreement. 

 

4. Select which components you want to install. For example, you may have each component to be installed 
on a different server.  

By default, Veeam Backup for Microsoft Office 365 will be installed to the C:\Program 
Files\Veeam\Backup and Replication\Explorers\Exchange\ directory. To install to a 
different location, click Browse and specify the destination folder. 
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5. Click Next and then click Install.  
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Installing Veeam Explorer for Microsoft 
SharePoint 
To install Veeam Explorer for Microsoft SharePoint, do the following: 

1. Open the folder with the Veeam Backup for Microsoft Office 365 distribution package. 

2. Run the Veeam Explorer for Microsoft SharePoint setup file. 

 

3. Read and accept License Agreement. 

 

4. Select which components you want to install. For example, you may have each component to be installed 
on a different server.  

By default, Veeam Backup for Microsoft Office 365 will be installed to the C:\Program 
Files\Veeam\Backup and Replication\Explorers\SharePoint\ directory. To install to a 
different location, click Browse and specify the destination folder.  
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5. Click Next and then click Install. 

NOTE: 

Veeam Explorer for Microsoft SharePoint and Veeam Explorer for Microsoft OneDrive for Business are 
distributed in one package. 
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Installing via Command Prompt 
You can install Veeam Backup for Microsoft Office 365, Veeam Explorer for Microsoft Exchange, and Veeam 
Explorer for Microsoft SharePoint using the unattended mode. This might be helpful, for example, when installing 
on Windows server Core Editions. 

The syntax of running an MSI file is as follows: 

msiexec /i <path_to_msi> /qn ADDLOCAL=<feature1>,<feature2> 

The following table comprises available components and their corresponding feature names for Veeam Backup 
for Microsoft Office 365. 

Component Feature name 

Server BR_OFFICE365 

Console CONSOLE_OFFICE365 

PowerShell PS_OFFICE365 

The following table comprises available components and their corresponding feature names for Veeam Explorer 
for Microsoft Exchange. 

Component Feature name 

UI BR_EXCHANGEEXPLORER 

PowerShell PS_EXCHANGEEXPLORER 

The following table comprises available components and their corresponding feature names for Veeam Explorer 
for Microsoft SharePoint. 

Component Feature name 

UI BR_SHAREPOINTEXPLORER 

PowerShell PS_SHAREPOINTEXPLORER 
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Examples 
To install Veeam Backup for Microsoft Office 365 and the PowerShell component. 

msiexec /i Veeam.Backup365.msi /qn ADDLOCAL=BR_OFFICE365,PS_OFFICE365 

To install Veeam Explorer for Microsoft Exchange along with the UI and PowerShell components. 

msiexec /i VeeamExplorerForExchange.msi /qn 
ADDLOCAL=BR_EXCHANGEEXPLORER,PS_EXCHANGEEXPLORER 

To install Veeam Explorer for Microsoft SharePoint along with the UI and PowerShell components. 

msiexec /i VeeamExplorerForSharePoint.msi /qn 
ADDLOCAL=BR_SHAREPOINTEXPLORER,PS_SHAREPOINTEXPLORER 

NOTE: 

When installing Veeam Explorer for Microsoft SharePoint, Veeam Explorer for Microsoft OneDrive for Business 
will be installed as well as it comes in a single package. 
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Deploying on Azure and AWS 
Veeam Backup for Microsoft Office 365 can be deployed on both Azure and Amazon Web Services (AWS) cloud 
platforms. 

When you deploy the solution on either of these platforms, Veeam treats both Azure and AWS VMs as if they 
were standard VMs without any particular differences. 

To deploy the Veeam Backup for Microsoft Office 365 solution on Azure or Amazon Web Services (AWS) cloud 
platforms, do the following: 

1. Install Veeam Backup for Microsoft Office 365 on an Azure or AWS virtual machine. For more 
information, see Installing Veeam Backup for Microsoft Office 365. 

2. Configure additional backup proxy servers. For more information, see Configuring Backup Proxy Servers. 

You can still use the default backup proxy server, which is the machine running Veeam Backup for 
Microsoft Office 365. Although, it is strongly recommended that you configure additional proxies to 
increase the overall production environment performance. 

3. Configure backup repositories to store your data. For more information, see Configuring Backup 
Repositories. 

4. Install Veeam Explorer for Microsoft Exchange and Veeam Explorer for Microsoft SharePoint to be able to 
explore and recover your data. For more information, see Installing Veeam Explorer for Microsoft 
Exchange and Installing Veeam Explorer for Microsoft SharePoint. 

After deployment is complete, you can add new Microsoft Office 365 organizations, create new backups, and 
explore the backup content as described in the following sections: 

 Adding Microsoft Organizations 

 Performing Organization Data Backup 

 Exploring Veeam Backup for Microsoft Office 365 Backups 

NOTE: 

If you are a service provider, you can back up your tenants organizations data according to the Mail Backup as 
a Service section. 
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Installing License 
After you install Veeam Backup for Microsoft Office 365, you will be prompted to provide the product license. You 
can dismiss this step and continue using the product without any license installed. In this case, you will have the 
Community Edition mode that allows you to process up to 10 user accounts in all organizations including 1TB of 
Microsoft SharePoint data. Such mode suggests using the community license, which is not limited in time, nor 
implies any limitations in terms of program functionality. See Installing License. 

To install a fully-functional license, do the following: 

1. Go to the main menu > License. 

2. In the License Information dialog, click Install and specify the full path to the required .lic file. 

3. Click Close to save the settings. 

 

Click Update now to update your current license with a newer version. You can select the Update license 
automatically (enables usage reporting) checkbox to automatically download and install a new license file 
once it is available. 

NOTE: 

To use the Update license automatically (enables usage reporting) option, Veeam Backup for Microsoft 
Office 365 requires predefined ports to be opened to access the Veeam auto-update server. See Used Ports. 
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Uninstalling Veeam Backup for Microsoft 
Office 365 
To uninstall Veeam Backup for Microsoft Office 365, do the following: 

1. Close all restore sessions in Veeam Explorer for Microsoft Exchange, Veeam Explorer for Microsoft 
SharePoint, and Veeam Explorer for Microsoft OneDrive. 

2. Open Veeam Backup for Microsoft Office 365, go to Backup Infrastructure > Backup Proxies and 
remove all backup proxies. See Removing Backup Proxy Server. 

3. Open Control Panel > Programs and Features select Veeam Backup for Microsoft Office 365 
and click Uninstall. 

To uninstall Veeam Explorer for Microsoft Exchange, Veeam Explorer for Microsoft SharePoint, and Veeam 
Explorer for Microsoft OneDrive for Business, go to Control Panel > Programs and Features, select Veeam 
Backup & Replication and click Uninstall. 

NOTE: 

The repository data will not be affected when uninstalling Veeam Backup for Microsoft Office 365. 
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Upgrading to Veeam Backup for Microsoft 
Office 365 2.0 
Application upgrade to version 2.0 is supported for the following versions of the application: 

 Veeam Backup for Microsoft Office 365 1.0 (product builds 1.0.0.860 and 1.0.0.912). 

 Veeam Backup for Microsoft Office 365 1.5 (product builds 1.5.0.1099, 1.5.0.1309 and 1.5.0.1318). 

IMPORTANT! 

Upgrade from the beta version of the application is not supported. 

Planning for Upgrade 
Consider the following when planning for upgrade: 

 Backup jobs settings and global configuration options (including notifications, file exclusions, and so on) 
will be preserved. 

 All modifications that have been made in the Config.xml file manually will be lost. 

 All backup jobs, including those running on schedule will be stopped during the upgrade process. 

Removing Beta Version 
Before attempting to install the GA version of Veeam Backup for Microsoft Office 365 2.0 on a machine with the 
beta version, do the following: 

1. Remove all remote backup proxies. See Removing Backup Proxy Server. 

2. Uninstall the beta version of the application. See Uninstalling Veeam Backup for Microsoft Office 365. 

3. Manually remove default repository folders and other files from the corresponding target location. The 
release version of the application is not compatible with the pre-release repository. 

4. Manually remove the content of the C:\ProgramData\Veeam\Backup365 directory. 

IMPORTANT! 

Ignoring the steps above will lead to the following error: "Service 'Veeam Backup for Microsoft Office 365 
Service' (Veeam.Archiver.Service) failed to start. Verify that you have sufficient privileges to start system 
services". 
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Upgrade Procedure 
To upgrade Veeam Backup for Microsoft Office 365, install Veeam Backup for Microsoft Office 365 version 2.0 as 
described in the following sections: 

 Installing Veeam Backup for Microsoft Office 365 

 Installing Veeam Explorer for Microsoft Exchange 

 Installing Veeam Explorer for Microsoft SharePoint 

After you install Veeam Backup for Microsoft Office 365 version 2.0, the following objects will be marked as Out 
of Date: 

 All backup repositories. 

 All backup proxies. 

 All backup jobs. 

To continue working with any of the above objects, you will need to upgrade them manually. 

Upgrading Backup Repositories 
For more information on upgrading backup repositories, see Upgrading Backup Repository. 

Upgrading Backup Proxies 
For more information on upgrading backup proxies, see Upgrading Proxy Server. 

Upgrading Backup Jobs 
To be able to process backup jobs that were created with previous versions of the application, Veeam converts 
backup jobs configuration parameters so that they are met for the version 2 accordingly. 

To upgrade backup jobs configuration parameters, do the following: 

1. Select the Out of Date node. 

2. Right-click a backup job and select Upgrade. 
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When a backup job is being upgraded, Veeam checks whether users whose mailboxes were added to the job 
thereof still exist in Office 365 organizations.  

Once the upgrade procedure is complete, you will be notified about the results. 

 

NOTE: 

If validation fails, Veeam will create temporary records for these mailboxes and add these records to the 
backup job processing list without being able to process them any further. To continue, remove unresolved 
mailboxes manually. 
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Checking for Updates 
Veeam Backup for Microsoft Office 365 provides you with the mechanism that checks for a newer version of the 
application every 24 hours by sending requests to the Veeam auto-update server. For more information on 
configuring automatic update notifications, see Configuring Update Notifications. 

If you want to manually check whether a newer version of the application is available, do the following: 

1. Go to the main menu and click Upgrade. 

2. Click Next to check for available updates. 

If a new version of the application is available, download it according to the subsequent steps of the 
wizard. 

 

NOTE: 

To access the auto-update server, Veeam Backup for Microsoft Office 365 requires predefined ports to be 
opened. See Used Ports. 
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Launching Veeam Backup for 
Microsoft Office 365 
To launch Veeam Backup for Microsoft Office 365, go to Start, select Veeam Backup for Microsoft Office 
365 and provide the following: 

1. Specify the server name or its IP-address. It can be your localhost or a remote Veeam Backup for 
Microsoft Office 365 server. 

2. Specify the port number. 

3. Specify user credentials to connect to the server. The account must be a member of the Local 
Administrator group on a target server. To use your current account, select Use Windows session 
authentication. 

 

To save the connection shortcut to your desktop, click Save shortcut at the bottom of the window. 

You can also use the command-line tool to launch Veeam Backup for Microsoft Office 365 by invoking the 
C:\Program Files\Veeam\Backup365\Veeam.Archiver.Shell.exe file with the following parameters: 

 /local=true 

To connect to Veeam Backup for Microsoft Office 356 that is installed on the local machine using the 
local system account.  

Example: 

C:\Program Files\Veeam\Backup365\Veeam.Archiver.Shell.exe /local=true 

 /host=<hostname> /port=<port> /usewincredentials=true 

To connect to Veeam Backup for Microsoft Office 356 that is installed on a remote machine using the 
/host and /port parameters. 

Example: 

C:\Program Files\Veeam\Backup365\Veeam.Archiver.Shell.exe /host=192.168.0.12 /port=9895 
/usewincredentials=true 
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 /host=<host> /port=<port> /account=<domain\accountName> 

To connect to Veeam Backup for Microsoft Office 356 that is installed on a remote machine using the 
/host and /port parameters. You can also provide the account under which you want to launch the 
controller using the /account=<domain\accountName> format. 

Example: 

C:\Program Files\Veeam\Backup365\Veeam.Archiver.Shell.exe /host=192.168.0.12 /port=9895 
/account=tech.local\Administrator 
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Getting to Know the User Interface 
Veeam Backup for Microsoft Office 365 provides you with the convenient user interface that allows you to 
perform required operations in a user-friendly manner. 

Main Menu 
The main menu comprises the following features: 

 Upgrade. Allows you to update your current Veeam Backup for Microsoft Office 365 version. For more 
information, see Checking for Updates. 

 General Options. Allows you to configure program options. For more information, see Configuring 
Veeam Backup for Microsoft Office 365 Options. 

 Console. 

o PowerShell. Opens the PowerShell toolkit. 

o Swagger. Opens Swagger Website. Unavailable until you enable the REST service. For more 
information, see Configuring RESTful API Settings. 

 Color Theme. Contains four different color schemes you can select for your application console. The 
selected color scheme will also be inherited by Veeam Explorers. 

 License. Shows the license information. For more information, see Installing License. 

 Help and Support. 

o Online help. Opens the online web help page. 

o Support Information. Launches the support information collection wizard. For more 
information, see Exporting Veeam Backup for Microsoft Office 365 Log Files. 

o About. Shows current product information. 

 Exit. Closes the program. 
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Main Application Window 
The main application window might be divided into five categories: 

1. The ribbon menu, which contains general program commands organized into logical groups represented 
as tabs: 

 The Home tab provides quick access to some common operations. For example, adding an 
organization to the scope, or removing it. This tab is visible in all views. 

 The View tab allows you to switch between the compact view and the full view mode either of 
which shows the backup job progress. You can also turn off the view completely. 

 The Jobs tab contains commands specific for the jobs. It will be displayed after you select the 
job node in the navigation pane. 

 The Backup Proxy tab contains commands specific for backup proxies and repositories. It will 
be displayed after you switch to the Backup Infrastructure view. 

2. The navigation area, which allows you to browse through the hierarchy of your infrastructure. At the 
bottom of the navigation area you can switch among various views such as Organizations, Backup 
Infrastructure, and the History view. 

3. The preview pane, which shows you the details about objects you have selected in the navigation area. 
For example, if you select an organization, all the information about the backup jobs that process 
selected organization's data will be available in the preview pane. 

4. The view switch, which allows you to switch among your infrastructure views. 
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5. The action view, which allows you to view details about backup jobs results. Here, you will be able to see 
what objects are being processed along with warnings and possible errors. You can also filter out 
unwanted records by enabling/disabling the corresponding checkboxes below. 
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Configuring Veeam Backup for 
Microsoft Office 365 
To configure application settings, go to the main menu, click General Options, and do the following: 

 On the Folders tab select mailbox folders you want to exclude from the processing. See Excluding 
Folders. 

 On the History tab specify the retention period for session data. See Configuring Retention for Session 
Data. 

 On the REST API tab configure required REST API settings. See Configuring RESTful API Settings. 

 On the Notifications tab configure e-mail settings for notifications. See Configuring Notification 
Settings. 

 On the Authentication tab configure authentication settings for tenants. See Configuring Authentication 
Settings. 

 On the Updates tab select required checkboxes to be notified about available updates automatically. 
See Configuring Update Notifications. 
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Excluding Folders 
Veeam Backup for Microsoft Office 365 allows you to exclude certain folders from processing. 

To exclude a folder, do the following: 

1. Go to the main menu and click General Options. 

2. Go to the Folders tab. 

3. Select mailbox folders you want to exclude and click OK. 

 

NOTE: 

When you select Deleted Items, both deleted and permanently deleted items will be excluded. 
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Configuring Retention for Session Data 
To configure a period during which Veeam Backup for Microsoft Office 365 should keep the historical job session 
data, do the following: 

1. Go to the main menu and click General Options. 

2. Go to the History tab. 

3. Specify the period during which the historical job sessions data should be kept. 

You can select Keep all sessions or specify the number of weeks where minimal allowed value is 1 
week. 
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Configuring RESTful API Settings 
To configure Veeam Backup for Microsoft Office 365 RESTful API settings, do the following: 

1. Go to the main menu and click General Options. 

2. Go to the REST API tab. 

3. Select the Enable REST Service checkbox. 

4. In the Authentication token lifetime (in minutes) field, specify the lifetime value for the 
authentication token provided by the server to the client. RESTful API authorization is based on OAuth 
2.0 Authorization Framework. 

5. In the HTTPS port field, specify the port number. 

6. Click Install to install a valid certificate file. 

For more information on installing certificates. see Installing SSL Certificate. 

 

https://tools.ietf.org/html/rfc6749
https://tools.ietf.org/html/rfc6749
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Installing SSL Certificate 
An SSL certificate is required when configuring RESTful API settings or enabling authentication with organization 
credentials for tenants. 

To install new certificate, proceed with any of the following options: 

 Generate new self-signed certificate 

 Select certificate from the Certificate Store of this Server 

 Import certificate from the PFX file 

 

Generating New Certificate 
To generate a new certificate, provide a friendly certificate name and click Finish. 

Once generated, the certificate data will be automatically added to the Installed certificate section of the 
Options dialog. 
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Selecting Certificate 
To select an existing certificate from the certificate store, pick a certificate and click Finish. 

Once certificated is selected, the certificate data will be automatically added to the Installed certificate section 
of the Options dialog. 

 

Importing Certificate 
Specify the path to the .PFX file and click Finish. 
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Configuring Notification Settings 
You can configure Veeam Backup for Microsoft Office 365 to send email notifications on backup job results. 

To configure the settings, do the following:  

1. Go to the main menu and click General Options. 

2. Go to the Notifications tab. 

3. Select Enable e-mail notifications. 

4. Specify the SMTP server address. Click Advanced and provide the following: 

 The port number.  

By default, Veeam Backup for Microsoft Office 365 uses standard connection to 
smtp.office365.com via port 587. To read more about Office 365 standard SMTP connection 
settings, see this Microsoft article. 

 Select Connect Using SSL for secure connection. 

 Select The SMTP server requires authentication and provide valid user credentials. 

5. In the From field, specify a notification sender address. 

6. In the To filed, specify the valid email address for a notification recipient. When specifying multiple 
addresses, use semicolon. 

7. By default, notification Subject will be as follows: [%JobResult%] %OrgName% - %JobName% 
(%MailboxCount% mailboxes), %Issues% issues. Where: 

 %JobResult%. A backup job result (Success, Warning, Failed). 

 %OrgName%. Office 365 organization for which the job was configured. 

 %JobName%. A backup job name. 

 %MailboxCount%. A number of processed mailboxes. 

 %Issues%. A number of mailboxes completed with Failed or Warning status. 

 %Time%. Date and time of backup job completion. 

8. Click Test Message to send a test message. 

https://support.office.com/en-us/article/How-to-set-up-a-multifunction-device-or-application-to-send-email-using-Office-365-69f58e99-c550-4274-ad18-c805d654b4c4
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By default, notifications will be sent on all backup job completion results including Success, Warning and Failure. 
To turn off notifications for certain results types, clear the corresponding checkboxes.  

If you configure backup jobs to perform retry attempts, then you can use the Suppress notifications until 
last retry option. In this case, notifications will only be sent after the last attempt according to the following: 

 If the job fails, then on the last retry. 

 If the job completes with Success or Warning, then on the last completion status. 

 If the job is scheduled to be terminated after the specified interval, then on the last attempt within that 
interval. 

NOTE: 

The email settings are applied to all backup jobs configured for all organizations added to Veeam Backup for 
Microsoft Office 365. 
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Configuring Authentication Settings 
Service Providers can allow tenants to view and recover their backups using the set of Veeam Explorers.  

To enable tenant authentication using organization credentials and instruct Veeam Backup for Office 365 to use 
the SSL certificate, do the following: 

1. Go to the main menu and click General Options. 

2. Go to the Authentication tab. 

3. Select Enable authentication with organization credentials. 

4. Click Install to specify SSL certificate.  

You can generate a new certificate or select an existing one using the same Select Certificate wizard 
as described in the Installing SSL Certificate section. The certificate information will be displayed in the 
corresponding Installed certificate fields. 

 

NOTE: 

You can use the same certificate for both Veeam Backup for Office 365 and Veeam Backup & Replication 
applications. 
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Configuring Update Notifications 
Veeam Backup for Microsoft Office 365 provides you with the mechanism that checks for a newer version of the 
application every 24 hours by sending requests to the Veeam auto-update server. 

If you want to be notified about available updates automatically, do the following: 

1. Go to the main menu and click General Options. 

2. Go to the Updates tab. 

3. Select the following checkboxes: 

 Automatically check and notify me on available updates. To be notified via a dialog 
message. 

 Send e-mail notification on available updates. To be notified via an email message. The 
recipient address will be taken from the SMTP configuration settings. See Configuring 
Notification Settings. 

 

To manually check whether a new version of the application is available, see Checking for Updates. 
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Configuring Backup Proxy Servers 
Proxy servers are responsible for handling backup processes during creating new backups or obtaining backup 
data from backup repositories.  

The default backup proxy server is the machine running Veeam Backup for Microsoft Office 365. Using additional 
machines as proxies allows you to take the load off the Veeam Backup for Microsoft Office 365 server and 
optimize the overall environment performance. It is recommended that after you install Veeam Backup for 
Microsoft Office 365, you also configure additional set of backup proxy servers to manage your data in a more 
efficient manner. 

Consider the following when adding new proxies: 

 A backup proxy server can be deployed on a physical or on a virtual machine. 

 Each backup proxy server can process one or several organizations. 

 An organization can be processed by one or several backup proxies using many-to-many connections. 

NOTE: 

Backup proxy servers and the Veeam Backup for Microsoft Office 365 server must be deployed within the 
same or a trusted domain. 
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Adding Backup Proxy Server 
When a new proxy server is being added, Veeam installs the Veeam Backup Proxy for Microsoft 
Office 365 Service component on a that machine to handle ingress/egress requests. You can manage this 
component by using the services.msc console. 

Once you have added a new proxy server, you can utilize its capacities to store your backup data on that 
machine by creating a new backup repository associated with this new proxy. For more information on adding a 
new backup repository, see Adding Backup Repository. 

To add a new backup proxy server, do the following: 

1. Go to Backup Infrastructure > Backup Proxies. 

2. Click Add Proxy on the ribbon menu. You can also use the Add backup proxy context menu 
command. 

 

3. Specify the proxy server DNS name or its IP address and the port number. Description is optional. You 
will not be able to change the host in future. 
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4. Specify the user account to connect to the machine which you want to use as a backup proxy server. The 
account must be a member of the local Administrator group on a target server. 

 

5. Click Next, wait until Veeam verifies connection and configuration settings and then click Finish. 
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Once a new proxy is added, you will be prompted to create a new repository associated with this proxy. 
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Removing Backup Proxy Server 
You can permanently remove any backup proxy server from the Veeam Backup for Microsoft Office 365 
infrastructure. 

NOTE: 

The default backup proxy server cannot be removed. 

When a backup proxy is being removed, the following will occur: 

 Information about this proxy will be removed from the configuration database.   

 Information about associated repositories will also be removed from the configuration database. These 
repositories will no longer be displayed in the management console, but the directories and files of the 
removed repository, however, remains intact. 

To remove a backup proxy, do the following: 

1. Go to Backup Infrastructure > Backup Proxies. 

2. In the preview pane, select a backup proxy you want to remove. 

3. Click Remove Proxy on the ribbon menu. You can also use the Remove context menu command. 

 

4. Wait until the operation is complete and click Finish. 
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72 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Editing Backup Proxy Server 
Sometimes you may need to edit the existing backup proxy server settings. 

To edit backup proxy settings, do the following: 

1. Go to Backup Infrastructure > Backup Proxies. 

2. In the preview pane, select a backup proxy you want to edit. 

3. Click Edit Proxy on the ribbon menu. You can also use the Edit context menu command. 

 

4. Veeam Backup for Microsoft Office 365 prohibits you from changing the host after it was created. 
Nevertheless, you can still change the port number. 
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5. Specify credential to connect to the server. The account must be a member of the local Administrator 
group on a target server. 

 

6. Wait until the operation is complete and click Finish. 
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Modifying Backup Proxy Server Properties 
You can specify the number of threads and the network bandwidth limit using the Properties dialog.  

 A thread defines the total number of proxy servers threads that are responsible for handling the backup 
jobs routine. By default, 64 threads are used. Depending on your environment configuration and 
capacities (i.e. low CPU or RAM deficiency), running too many threads may significantly reduce the 
efficiency due to possible throttling errors or connection failures. As each production environment 
operates under different equipment capacities, Veeam allows you to explicitly define the number of 
threads that your infrastructure is potentially able to handle without losing performance. 

 The network bandwidth limit is applied per proxy, not per thread. 

To set the number of threads along with the network bandwidth limit, do the following: 

1. Go to Backup Infrastructure > Backup Proxies. 

2. In the preview pane, right-click a backup proxy and select Properties. 

 

3. In the Set the number of threads to field, specify the number of threads. 

4. Select the Limit network bandwidth check box and specify the required network bandwidth limit. 
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Rescanning Backup Proxies 
A backup proxy server might be offline for a variety of different reasons. If some proxies go offline, you may 
need to perform manual proxy rescan so that they become available for Veeam. 

During rescanning, Veeam Backup for Microsoft Office 365 will refresh proxy status and re-connect with a proxy 
once it is online. 

NOTE: 

Proxies are rescanned automatically when you start Veeam Backup for Microsoft Office 365.  

To rescan a proxy, do the following: 

1. Go to Backup Infrastructure > Backup Proxies. 

2. In the preview pane, select a backup proxy to rescan. 

3. Click Rescan on the ribbon menu. You can also use the Rescan context menu command. 

 

NOTE: 

To rescan all proxies configured in your environment, right-click the Backup Proxies node and select 
Rescan. 
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Upgrading Proxy Server 
To communicate with proxy servers, Veeam uses the proprietary component — Veeam Backup Proxy for 
Microsoft Office 365 Service that is installed on a proxy machine during adding a new backup proxy 
server. If this component becomes outdated, you will need to upgrade it. 

To upgrade the component, do the following: 

1. Go to the Backup Infrastructure view. 

2. In the preview pane, select a proxy server you want to upgrade and on the ribbon menu, or using the 
corresponding context menu command, click Upgrade. 

To upgrade all proxy servers simultaneously, select the Backup Proxies node and click Upgrade. 

 

3. Select a proxy to upgrade. You can select multiple proxies at the same time. 
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4. Specify user credentials to access the server. The account must be a member of the Local 
Administrator group on a target server. 

 

Once the upgrade procedure is complete, you will be notified about the results. 
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Configuring Backup Repositories 
Backup repositories are used to store organization backups created with Veeam Backup for Microsoft Office 365. 

The following types of repositories are supported: 

 A local folder on a backup proxy. The default backup repository is the C:\VeeamRepository directory 
on the localhost. 

 Direct Attached Storage (DAS) connected to the backup server, including external USB/eSATA drives and 
raw device mapping (RDM) volumes. 

 Storage Area Network (SAN). The backup server must be connected to the SAN fabric via hardware or 
virtual HBA, or software iSCSI initiator. 

 SMB 3.0 share (experimental support). 

 Azure and/or AWS virtual machines. For more information on deploying the solution on either of these 
platforms, see Deploying on Azure and AWS. 

Storage volumes that host the archive repository must be formatted with NTFS or ReFS. 

IMPORTANT! 
 Consider that Microsoft Windows 7 SP1 and Microsoft Windows 2008 R2 SP1 do not support the 

SMB 3.0 share as a storage system. To use the SMB 3.0 share as a storage system, make sure you 
are using Microsoft Windows 8 or Microsoft Windows 2012 or higher. 

 To set a network drive\UNC path to the repository on a network share, ensure that the Local 
System account has sufficient rights (I.e. Read and Write) to access the corresponding network 
share. 
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Adding Backup Repository 
This section describes how to add a new backup repository, associate it with a relevant proxy server, and define 
a retention policy that will be applied during archiving your production data. 

To add a new repository, do the following: 

1. Go to Backup Infrastructure > Backup Repositories.  

2. Click Add Repository on the ribbon menu. You can also use the Add backup Repository context 
menu command. 

 

3. Specify the repository name and optional description. 
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4. Specify the backup proxy server and the repository location. Click Get free space to know the available 
space.  

To use a network share folder, provide the path manually. Network share browsing is not supported. 

Note that you will not be able to change the backup proxy in future, nor you will be able to change the 
path. For more information on backup proxy servers, see Configuring Backup Proxy Servers. 

 

5. Specify the retention policy. For more information on configuring the retention policy, see Understanding 
Retention Policy. 
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Understanding Retention Policy 
To decrease the amount of data transferred over the network, you apply a retention policy. A retention policy 
helps you analyze your Office365 organizations information before placing the actual organization data into the 
repository. 

You configure the retention policy during adding/editing a backup repository. For more information, see Adding 
Backup Repository and Editing Repository Settings. 

For example, if the retention policy is set to 3 years, this will work as follows: 

 When you start a backup job, Veeam Backup for Microsoft Office 365 will first analyze the metadata of 
your organization. In particular, it will check the last item modification date and calculate the "age" of the 
item. 

For example, if a backup job is about to be running at 10:00 AM on September, 15, 2017 and last 
modification was made at 10:00 AM on September, 1, 2014. This means that the item "age" is 3 
years and 2 weeks. 

 The "age" is then compared with the value that is set in the Retention policy for backed up data 
drop-down list, which is 3 years in our example. 

If the "age" exceeds the specified interval, then, such organization items will not be processed. 

In our example, an item is older than 3 years, therefore, it will be skipped from processing. On the 
contrary, an item that was last modified at 11:55 AM on September 16, 2014, will be archived 
successfully. 

This retention policy is then applied to the backup data on a target repository according to the following: 

 After all suitable items are placed into the target repository, Veeam Backup for Microsoft Office 365 
checks the retention policy application schedule. This setting defines how often Veeam should analyze 
the "age" of the data in the backup comparing it with the specified threshold (a retention period), which 
is 3 years in our example. 

 The retention period starting point is set to the current date/time. Obsolete data is removed from the 
repository automatically according to the following: 

o An item will be removed from the repository if its "age" exceeds the threshold.  

o The datastore will be removed from the repository when the last remaining items in the archive 
have their retention period expired and no data is arrived by that moment. 
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Editing Repository Settings 
This section explains how to edit repository settings such as the repository name along with its description and 
the retention policy rules. 

To edit repository settings, do the following: 

1. Go to Backup Infrastructure > Backup Repositories.  

2. In the preview pane, select the repository you want to edit. 

3. Click Edit Repository on the ribbon menu. You can also use the Edit context menu command. 

 

4. Specify new details for the backup repository. 
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5. Veeam Backup for Microsoft Office 365 prohibits you from changing the Backup repository location after 
it was created. This step is described to adhere to the consistency of the wizard. 

 

6. Specify retention policy and click Finish. For more information on configuring the retention policy, see 
Understanding Retention Policy. 
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Removing Backup Repository 
You can remove a repository from the application scope when you no longer need it. 

Before removing a repository, make sure you re-map the corresponding backup jobs to another valid repository. 
Once a repository is removed the corresponding restore points will become unavailable. 

To remove a repository, do the following: 

1. Go to Backup Infrastructure > Backup Repositories. 

2. In the preview pane, select the repository you want to remove. 

3. Click Remove Repository on the ribbon menu. You can also use the Remove context menu command. 
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Upgrading Backup Repository 
When you upgrade your Veeam Backup for Microsoft Office 365 application with a newer version, your Veeam 
Backup for Microsoft Office 365 repository databases will be marked as out of date. To continue working with 
these repositories, you will need to upgrade them first. 

To upgrade Veeam Backup for Microsoft Office 365 repository databases, do the following: 

1. Go to the Backup Infrastructure view. 

2. Go to the Backup Repositories > Out of Date node. 

3. Right-click a backup repository and click Upgrade. 
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Adding Microsoft Organizations 
Before you can create backups of your Microsoft O365 organizations, you need to add these organizations to the 
program scope. 

To add a new organization to the Veeam Backup for Microsoft Office 365 scope, do the following: 

1. Switch to the Organizations view and go to the Home tab. 

2. Click Add Org on the toolbar or select the Organizations node in the navigation pane and right-click 
Add organization. 

 

3. Select the organization deployment type. 
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4. Click Next to proceed to one of the following configuration scenarios: 

 Adding Microsoft Office 365 Organizations 

 Adding On-Premises Organizations 

 Adding Hybrid Organizations 
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Adding Microsoft Office 365 Organizations 
To add a new Microsoft Office 365 organization, do the following: 

1. Specify the Microsoft Azure region your organizations belong to. 

2. Specify valid credentials to connect to the Microsoft Office 365 organization. 

The user account must be provided in either of the following formats: user@domain.com or 
user@domain.onmicrosoft.com. 

3. Select Exchange Server and/or SharePoint Server checkboxes to automatically grant required 
permissions and assign appropriate roles to the account to access organizations thereof. For more 
information, see Required Permissions. 

4. Click Next and wait until Veeam verifies connection and organization parameters. 

5. Click Finish.  

Some actions might be failing during verification. To know more about the reason of the failure, see the 
message under the Status column. 

IMPORTANT! 

To connect to Microsoft Office 365 organizations that belong to China or Germany regions, make sure you 
select the Use custom Veeam application to connect to Microsoft Graph checkbox. For more 
information on this feature, see Connecting to Microsoft Graph. 

 

NOTE: 
 If impersonation was not granted, Veeam Backup for Microsoft Office 365 will display an error 

message when checking organization parameters. Further mailbox processing will not be possible.  
 If impersonation was granted manually using PowerShell with some accounts filtered out (i.e. 

partial impersonation), then you will see the corresponding notification message. If you decide to 
fully grant impersonation, you can re-run parameters check right afterwards. 
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Connecting to Microsoft Graph 
Veeam utilizes Microsoft Graph API to access Azure Active Directory resources and retrieve information about 
your Microsoft Office 365 organizations. For more information about Microsoft Graph and types of requests that 
are being used during communicating with Microsoft Graph, see this Microsoft article and Microsoft Graph 
Requests respectively. 

To connect to Microsoft Graph, Veeam uses two different approaches involving two different application types: 

 The default Microsoft application. 

 The custom Veeam Backup for Microsoft Office 365 application. 

Using Microsoft Application 
This application is installed by default by Microsoft and allows Veeam to connect to Microsoft Office 365 
organizations that belong to any Microsoft Azure region other than China or Germany. 

Using Veeam Backup for Microsoft Office 365 Application 
To connect to Microsoft Office 365 organizations that belong to China or Germany regions, you must use the 
proprietary Veeam application — Veeam Backup for Microsoft Office 365. 

This application is installed automatically after you select the Use custom Veeam application to connect to 
Microsoft Graph checkbox during adding Microsoft Office 365 organizations and provides Veeam with the 
appropriate permission set to access and work with your Microsoft Office 365 organizations data (e.g. retrieving 
users information, etc.). For more information on adding new organizations and working with the wizard, see 
Adding Microsoft Office 365 Organizations. 

To be able to install the application, Veeam requires either of the following roles to be assigned to your Microsoft 
Office 365 account: 

 Application administrator. For more information on this role, see this Microsoft article. 

 Cloud application administrator. For more information on this role, see this Microsoft article. 

To assign any of these roles, open the Azure Active Directory portal, go to Azure Active Directory > Users > 
%User% > Directory role and click Add role. 

Once installed, the application can be found in the Enterprise applications - All applications section of your 
Azure Active Directory admin center. 

To see what permissions have been given to the application, click the Veeam Backup for Microsoft 
Office 365 application name and select Permissions. 

https://developer.microsoft.com/en-us/graph/docs/concepts/overview
https://docs.microsoft.com/en-us/azure/active-directory/users-groups-roles/directory-assign-admin-roles#application-administrator
https://docs.microsoft.com/en-us/azure/active-directory/users-groups-roles/directory-assign-admin-roles#cloud-application-administrator
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NOTE: 

The Use custom Veeam application to connect to Microsoft Graph option is selected by default for all 
regions. In fact, Veeam encourages you to use this option regardless of the region type of your Microsoft 
Office 365 organizations. 

Microsoft Graph Requests 
The following types of requests are used when working with Microsoft Graph: 

 Retrieve the properties and relationships of currently authenticated organization. For more information, 
see this Microsoft article. 

 Get groups and directory roles that the user is a direct member of. For more information, see this 
Microsoft article. 

 Retrieve a list of user objects. For more information, see this Microsoft article. 

 List all the groups available in an organization. For more information, see this Microsoft article. 

https://developer.microsoft.com/en-us/graph/docs/api-reference/v1.0/api/organization_get#permissions
https://developer.microsoft.com/en-us/graph/docs/api-reference/v1.0/api/user_list_memberof#permissions
https://developer.microsoft.com/en-us/graph/docs/api-reference/v1.0/api/user_list_memberof#permissions
https://developer.microsoft.com/en-us/graph/docs/api-reference/v1.0/api/user_list#permissions
https://developer.microsoft.com/en-us/graph/docs/api-reference/v1.0/api/group_list#permissions
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Adding On-Premises Organizations 
When you select On-Premises, you can choose what On-Premises organizations you want to add. You can add 
either one or both Microsoft Exchange and Microsoft SharePoint organizations at the same time using the same 
wizard. 

To learn more about adding On-Premises organizations, see the following sections: 

 Adding Microsoft On-Premises Exchange Organization 

 Adding Microsoft On-Premises SharePoint Organization 

 Adding On-Premises Organizations of Both Types 
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Adding Microsoft On-Premises Exchange 
Organization 
To add a new On-Premises Microsoft Exchange organization, do the following: 

1. Select the Microsoft Exchange checkbox and click Next. 

 

2. Specify Microsoft Exchange server EWS endpoint URL. For example, e.mail.mycompany.com. If 
necessary, contact your Exchange administrator to know the URL. If the server requires SSL connection, 
select Use SSL.  

Select to skip one or several verification steps using the following checkboxes: 

 Skip certificate trusted authority verification 

 Skip certificate common name verification 

 Skip revocation check 

3. Specify valid credentials to connect to the Microsoft Exchange organization.  

The user account must be provided in either of the following formats: domain\account or 
account@domain. For more information on required permissions, see the Required Permissions section. 

4. Select the Configure User Account checkbox to let Veeam automatically perform the following: 

 Check the connection to the Exchange Web Services (EWS) and PowerShell services. 

 Check if impersonation has been granted. If not, Veeam checks whether the Office 365 
organization is in the dehydration state or not. In the latter case Veeam checks the 
Organization Config role, which allows to activate the dehydration state. Such state can only 
be applied to the Office 365 organization, when the organization has been created but has 
never been accessed by the administrator. 

 Check whether the Organization Management and Role Management roles are assigned 
to the user. These roles are required to grant impersonation. 

If you leave this checkbox unchecked, Veeam will perform the following: 

 Check the connection to the Exchange Web Services (EWS) and PowerShell services. 
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 Check whether the View-Only Configuration role is assigned to the user to be able to fetch 
organization parameters such as the organization name and organization ID. 

 Check whether the View-Only Recipient role is assigned to the user to be able to fetch and 
display organization users. 

 Check whether the ApplicationImpersonation role has been granted. 

5. Select the Configure throttling policy checkbox to check if the throttling policy exists. If not, Veeam 
checks if the RecipientPolicies role exists. If so, the throttling policy might be assigned to the user. 

 

6. Wait until the connection is established and click Finish.  

Some actions might be failing during verification. In this case, a message will be shown under the 
Status column displaying the reason of the failure. 
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Adding Microsoft On-Premises SharePoint 
Organization 
To add a new On-Premises Microsoft SharePoint organization, do the following: 

1. Select the Microsoft SharePoint checkbox and click Next. 

 

2. Specify the Microsoft SharePoint server address and the WinRM port number. See User Authentication 
For SharePoint Organization. 

3. Select to skip one or several verification steps using the following checkboxes: 

 Skip certificate trusted authority verification. 

 Skip certificate common name verification. 

 Skip revocation check. 

4. Specify valid credentials to connect to the Microsoft SharePoint organization.  

The user account must be provided in either of the following formats: domain\account or 
account@domain. For more information on required permissions, see the Required Permissions section. 

5. Select the Automatically grant required permissions and assign roles checkbox to automatically 
add a user to the SharePoint site collection and grant this user administrative privileges to be able to 
access Microsoft SharePoint sites. Selecting this option also grants access to the User Profile Service to 
be able to work with OneDrive data. 
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6. Wait until the connection is established and click Finish.  

Some actions might be failing during verification. In this case, a message will be shown under the 
Status column displaying the reason of the failure. 
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Adding On-Premises Organizations of Both Types 
To add both On-Premises Microsoft Exchange and On-premises Microsoft SharePoint organizations, do the 
following: 

1. Select both Microsoft SharePoint and Microsoft Exchange checkboxes and click Next. 

 

2. Sequentially perform the steps described in the Adding Microsoft On-premises Exchange Organization 
and Adding Microsoft On-premises SharePoint Organization sections. 

3. Wait until the connection is established and click Finish. Some actions might be failing during 
verification. In this case, a message will be shown under the Status column displaying the reason of the 
failure. 
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Adding Hybrid Organizations 
You can add Microsoft Office 365, On-Premises SharePoint, and On-Premises Exchange organizations according 
to the following: 

1. Specify connection settings for the Microsoft Office 365 organization as described in the Adding Microsoft 
Office 365 Organizations section. 

2. Specify connection settings for the On-Premises Exchange and/or SharePoint organization as described in 
the Adding On-Premises Organizations section. 

NOTE: 

Microsoft Office 365, On-Premises SharePoint, and On-Premises Exchange organizations must belong to the 
same organization. 
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Editing Organization Parameters 
After you have added an organization, you may want to edit its parameters such as the organization deployment 
type, user name and/or password, or permissions that have been previously given to that account. 

When editing organization parameters, you are basically going through the steps of the same wizard that was 
used when you were adding new organizations to the program scope. For more information, see Adding 
Microsoft Organizations. 

NOTE: 

You cannot change Office 365 organization deployment type to the On-Premises type. 

To edit organization parameters, do the following: 

1. Go to the Organization view, select an organization you want to edit and click Edit Org on the ribbon 
menu. You can also use the Edit command from the context menu. 

 

2. Choose the organization deployment type. 
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3. Provide Microsoft Office 365 connection settings.  

The wizard you see at this step depends on the deployment type of the organization that is being edited. 

 

4. Wait until the operation is complete and click Finish. 



 

105 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Removing Organizations 
You can remove an organization from the application scope if you no longer need it. 

When an organization is being removed, Veeam also removes the entire collection of backup jobs configured for 
this organization. The actual backup data, however, remains intact in corresponding backup repositories. For 
more information on removing backup repositories, see Removing Backup Repository. 

To remove an organization, do the following: 

1. Go to the Organizations view. 

2. In the navigation pane, select an organization you want to remove and click Remove Org on the ribbon 
menu. You can also right-click an organization and select Remove organization. 
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Performing Organization Data 
Backup 
To create a backup of Microsoft Office 365 and/or On-Premises organizations data, you first need to create a 
backup job. 

A backup job contains configuration settings that define the behavior of how your organization data should be 
archived. 

To learn more about creating and managing backup jobs in Veeam Backup for Microsoft Office 365, see the 
following sections: 

 Understanding Organization Object Types 

 Creating Entire Organization Backup 

 Selecting Organization Items to Backup 

 Managing Backup Jobs 

 Viewing Backup Job Statistic 

To learn how to explore your backups, see Exploring Veeam Backup for Microsoft Office 365 Backups. 

TIP: 

Information provided in this section can also be applied when creating backups using cloud platforms such as 
Azure and/or AWS. For more information on how you can deploy the Veeam Backup for Microsoft Office 365 
solution on these platforms, see Deploying on Azure and AWS. 
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Understanding Organization Object Types 
This section explains object types and their corresponding processing options that you can select when creating 
and configuring a backup job in Veeam Backup for Microsoft Office 365.  

There are four available object types: 

 Groups. Consists of O365 groups (available only in Office 365 organizations), Security groups, 
Distribution groups, and Dynamic distribution groups. 

 Users. Consists of Users, Shared mailboxes (available only in Office 365 and Exchange organizations), 
and Public mailboxes (available only in Office 365 and Exchange organizations). 

 Sites. Consists of organization sites and subsites. 

 Organizations. Contains organization objects and their corresponding processing options. 

Each of these object types consists of the predefined set of processing options such as Mail, Archive, 
OneDrive, Site, Group Mail, and Group Site which you can select/deselect to make data retrieval even more 
precise. 

 



 

108 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Groups 
The following table explains group types and their corresponding processing options. 

Group Type Processing options for Office 365 
organizations 

Processing options for Exchange 
organizations 

O365 group (available only in 
Office 365 organizations) 

When configuring Office 365 
organizations, the following set of 
processing options is available: 

 Members with Mail, Archive, 
OneDrive, and Site options 

 Group Mail 
 Group Site 

N/A 

Security group Members with Mail, Archive, OneDrive, 
and Site options 

Members with Mail and/or Archive 
options 

Distribution Group 

Dynamic Distribution Group 

NOTE: 

Groups are not available in Microsoft SharePoint On-premises organizations. 

Users 
The following table explains user types and their corresponding processing options. 

User Type Processing options for Office 
365 organizations 

Processing options for 
Exchange organizations 

Processing options for 
SharePoint organizations 

User Mail, Archive, OneDrive, and 
Site options 

Mail and/or Archive options OneDrive and/or Site options 

Shared mailbox (available 
only in Office 365 and 
Exchange organizations) 

N/A 

Public mailbox (available 
only in Office 365 and 
Exchange organizations) 
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Sites 
Objects of the Site type have the following characteristics: 

 Objects of this type are not available in On-Premises Exchange organizations. 

 Objects of this type do not have any processing options. Therefore, the Edit button will be unavailable. 

 When you select Sites, you can either select the root site node which automatically selects the entire 
subsite collection belonging to that root, or you can select only certain subsite elements of the root site. 
In the latter case, the root site will be deselected as Veeam does not allow to select subsite elements 
along with having the root site selected at the same time. 

NOTE: 

Due to possible access limitations, some sites might be unavailable. You can hover over an unavailable site to 
know the reason. 

Organizations 
The following table explains organization types and their corresponding processing options. 

Processing options for Office 365 
organizations 

Processing options for Exchange 
organizations 

Processing options for SharePoint 
organizations 

Mail, Archive, OneDrive, and Site 
options 

Mail and/or Archive options OneDrive and/or Site options 

When adding objects of this type, consider that you can only add an organization, the backup job of which is 
being edited. For example, you have three organizations of different types (i.e. Office 365, Exchange, and 
SharePoint) added to the application scope and want to add an object of the Organization type to the Office 
365 organization's backup job. In this case, you will be able to add only Office 365 organization. Neither 
Exchange nor SharePoint organization will be available in this scenario. 
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Creating Entire Organization Backup 
The backup entire organization option creates a backup file that contains the entire object collection for the 
selected organization except those objects processed by another jobs.  

For example, you create a backup job (let's call it BETA) to back up an entire Office 365 organization that 
comprises A, B, and C objects. Then, you create another backup job using the Backup the following items 
option and explicitly add both B and C objects to the processing list of this job (let's call it ALPHA). In this case, 
both B and C objects will no longer be processed by the BETA job. Instead, these objects will be archived by the 
ALPHA job. The object A, however, will still be processed by the BETA job. 

Before you begin with this section, make sure that you have read the Understanding Organization Object Types 
section to learn more about available object types and their corresponding processing options. 

To create an entire organization backup job, do the following: 

1. In the navigation pane, select an organization you want to backup. 

2. Go to the Home tab of the Organizations view and click Backup. You can also use the Backup 
command from the context menu. 

3. Proceed to the Step 1. Specify the Job Name section. 

 

NOTE: 

You can create only one entire organization backup job per organization. 
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Step 1. Specify Backup Job Name 
Specify the job name and optional description. 
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Step 2. Select Items to Backup 
Select the Backup entire organization option. 
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Step 3. Select Items to Exclude 
To exclude certain objects from processing, click Add and choose what Users, Groups and/or Sites objects you 
want to exclude. 

Depending on the organization type, you will not be able to exclude Sites objects for On-Premises Exchange 
organizations, nor you will be able to exclude Groups objects for On-Premises SharePoint organizations. 

 

To remove the object, select it and click Remove. 

Editing Exclusion Settings 
By default, when you exclude an object, Veeam selects all processing options for this object. To explicitly specify 
the processing options you need, select an object and click Edit. For more information on available object types 
and their corresponding processing options, see Understanding Organization Object Types. 

NOTE: 

You can edit exclusion settings for any objects except objects of the Site and Public Mailbox types. 

The figure below demonstrates editing the exclusion settings for the Office 365 group (Amazing Team). In the 
example below, the Archive, OneDrive, and Group Mail data will be excluded from the backup for the 
Amazing Team group whereas Mail, Site, and Group Site data will be added to the backup. 
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You can see the excluded processing options under the Exclude column of the wizard. 
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Step 4. Specify Backup Proxy and Repository 
Select the backup proxy server and the backup repository to process and store your data. To learn more about 
backup proxies and backup repositories, see Configuring Backup Proxy Servers and Configuring Backup 
Repositories respectively. 
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Step 5. Specify Scheduling Options 
Specify scheduling options for the backup job and click Create to finalize the backup job configuration. 

 

To explicitly Terminate job if it exceeds allowed backup window, select the corresponding checkbox and 
click Window. In the Time Periods window, specify the allowed and prohibited hours for the backup job.  

Click OK to return to the backup job configuration wizard and click Create.  

 

If you select the Run the job when I click Create checkbox, the backup job will be started automatically. 
Otherwise, you can start a backup job manually later. See Managing Backup Jobs. 
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Selecting Organization Objects to Backup 
This section describes how to select organization objects and add these objects to your backup. To learn how to 
back up an entire organization, see Creating Entire Organization Backup. 

Before you begin with this section, make sure that you have read the Understanding Organization Object Types 
section to learn more about available object types and their corresponding processing options. 

To create a backup job that consists of certain selected objects, do the following: 

1. In the navigation pane, select an organization you want to backup. 

2. Go to the Home tab of the Organizations view and click Backup. You can also use the Backup 
command from the context menu. 

3. Proceed to the Step 1. Specify the Job Name section. 
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Step 1. Specify Backup Job Name 
Specify the job name and optional description.  

 



 

119 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Step 2. Select Items to Backup 
Select the Backup the following items option and click Add to select objects you want to backup. 

 

Depending on the organization type, you can combine Users, Groups, Sites, and Organization. When 
creating a backup job for On-Premises Exchange organizations, you will not be able to add Sites objects, nor you 
will be able to add Groups objects for On-Premises SharePoint organizations. 

TIP: 

You can add objects of different types using the same wizard. For more information, see Adding Objects of 
Different Types. 

By default, when you add a new object, Veeam selects all processing options for this object. To explicitly specify 
the processing options you need, select an object and click Edit. For more information on available object types 
and their corresponding processing options, see Understanding Organization Object Types. 

For example, you do not want to back up Archive and Site data for Mike Wilde (the user from the figure above). 
For that, do the following: 

1. Select the user under the Object column. 

2. Click Edit. 

3. Deselect Archive and Site processing options. 

4. Click OK. 
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NOTE: 

You cannot edit users with the Public Mailbox type, nor you can edit the Site objects. 

Adding Objects of Different Types 
To simultaneously add objects of different types, you can use the switch group at the top-right corner of the Add 
Objects dialog without having to click the Add button each time you need to add a new object of another type. 

The figure below demonstrates the Group object view with the corresponding icon selected at the top-right 
corner. For example, if you want to add Users objects, you can click the corresponding button with the person 
icon next to the Refresh button to switch to the Users view. 

To quickly find necessary items, use the search field at the bottom of the dialog. 
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Step 3. Select Items to Exclude 
To exclude certain objects from processing, click Add and choose what Users, Groups and/or Sites objects you 
want to exclude.  

Depending on the organization type, you will not be able to exclude Sites objects for On-Premises Exchange 
organizations, nor you will be able to exclude Groups objects for On-Premises SharePoint organizations. 

 

To remove the object, select it and click Remove. 

Editing Exclusion Settings 
By default, when you exclude an object, Veeam selects all processing options for this object. To explicitly specify 
the processing options you need, select an object and click Edit. For more information on available object types 
and their corresponding processing options, see Understanding Organization Object Types. 

NOTE: 

You can edit exclusion settings for any objects except objects of the Site and Public Mailbox types. 

The figure below demonstrates editing the exclusion settings for the Office 365 group (Amazing Team). In the 
example below, the Archive, OneDrive, and Group Mail data will be excluded from the backup for the 
Amazing Team group whereas Mail, Site, and Group Site data will be added to the backup. 
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You can see the excluded processing options under the Exclude column of the wizard. 
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Step 4. Specify Backup Proxy and Repository 
Select the backup proxy server and the backup repository to process and store your data. To learn more about 
backup proxies and backup repositories, see Configuring Backup Proxy Servers and Configuring Backup 
Repositories respectively. 

 



 

124 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Step 5. Specify Scheduling Options 
Specify scheduling options for the backup job and click Create to finalize the backup job configuration. 

 

To explicitly Terminate job if it exceeds allowed backup window, select the corresponding checkbox and 
click Window. In the Time Periods window, specify the allowed and prohibited hours for the backup job. 

Click OK to return to the backup job configuration wizard and click Create.  

 

If you select the Run the job when I click Create checkbox, the backup job will be started automatically. 
Otherwise, you can start a backup job manually later. See Managing Backup Jobs. 
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Managing Backup Jobs 
Veeam Backup for Microsoft Office 365 provides the following commands to manage your backup jobs: 

 Start/Stop. To start or stop a backup job.  

Using the Stop command implies freezing the current backup job state preserving what has already 
been backed up allowing you to continue where you left off. 

 Enable/Disable. To enable or disable a backup job.  

The former option enables a backup job if it has previously been disabled so that it can be executed on-
demand while the latter option does the opposite. When a backup job is disabled, the schedule that you 
might have configured for this job will not be applied. 

 Edit. To edit backup job settings such as the backup job name and optional description, the list of items 
to be backed up, the list of items to be excluded, a proxy server name along with the associated 
repository, and a schedule that you might want to assign to this job so that it can be executed 
automatically. 

New settings will be applied during the next backup job run. 

 Delete. To remove a backup job. 

When a backup job is being removed, its corresponding record in the configuration database will be 
removed as well, but the actual backup data, however, remains unaffected and can be accessed by using 
the Explore command. 

 Explore. To launch the corresponding Veeam Explorer tool to explore the content of a backup file. See 
Exploring Veeam Backup For Microsoft Office 365 Backups. 
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Viewing Backup Job Statistic 
This section describes how you can review statistical information on your backup job execution results. 

The backup job statistical information is available in the following views: 

 Organizations View 

 History View 

Organizations View 
Apart from many other abilities the Organization view provides you with, it also allows you to review statistical 
information on your backup jobs. 

To review backup job statistics, do the following: 

1. Go to the Organizations view. 

2. In the navigation pane, select an organization. 

3. In the preview pane, select a backup job statistical information of which you want to review. 

Statistical information consists of the backup job name, status, details on the latest run, the date and time of the 
last backup created by this job, time of the next run, and the backup repository used to store the data. 

When you select a backup job, the Action pane below shows session results, including but not limited to session 
status, bottleneck (if any), last backup date and time, data processing rate (read and write), session duration, 
the number of processed items, the amount of transferred data, etc. 

At the bottom of the main window, you can examine job session log records. Use the Success, Warnings, or 
Errors filter checkboxes to display records you need. 
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History View 
When you open the History view, you can explore the list of all sessions for all jobs configured for all 
organizations added to the Veeam Backup for Microsoft Office 365 scope as per operation type, which can be 
either Backup or Restore. 

Use the Stop button on the toolbar to stop the running session. 

To view the restore session details, select the Restore node and choose the session you want to view 
information for. The details will be available under the Message column. 
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Exploring Veeam Backup for 
Microsoft Office 365 Backups 
After you create a backup file consisting of Microsoft Office 365 and/or On-Premises organizations data, you can 
then explore its content by using Veeam Explorers. 

Depending on the data types in a backup file, you can explore the following: 

 Microsoft Exchange mailboxes, folders, messages, tasks, contacts, and items. 

 Microsoft SharePoint sites, libraries, and items. 

 Microsoft OneDrive items and folders. 

For each of these types Veeam provides the corresponding Explore option that can be invoked on the following 
objects: 

 Backup job 

 Single Microsoft Office 365 Organization 

 All Microsoft Office 365 Organizations 

TIP: 

For more information on creating new backups, see Performing Organization Data Backup. 

Exploring Backup Jobs 
To explore the backup content created by the backup job, do the following: 

1. In the Organizations view, select an organization that contains backup jobs you want to explore. 

2. In the preview pane, right-click a backup job and select either of the following options: 

a) Explore latest <product> state of <date>. To explore the latest backup state. 

b) Explore point-in-time state. To select a point-in-time state when the backup was created. 
For more information, see Explore Point-in-time State. 

3. Depending on the data type you are exploring, proceed with one of the following sections to learn more 
about working with the backup data using Veeam Explorers: 

 Processing Microsoft Exchange Backups 

 Processing Microsoft SharePoint Backups 

 Processing Microsoft OneDrive Backups 
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Exploring Single Organization 
With this option selected, Veeam will load all backup data that was created by all backup jobs configured for the 
selected organization, including those backup jobs that were permanently removed from the configuration. The 
backup content will be displayed using a single instance of Veeam Explorer. 

To explore the backup content created for the selected organization, do the following: 

1. In the Organizations view, right-click an organization you want to explore and select either of the 
following options: 

a) Explore latest <product> state of <date>. To explore the latest backup state. 

b) Explore point-in-time state. To select a point-in-time state when the backup was created. 
For more information, see Explore Point-in-time State. 

2. Depending on the data type you are exploring, proceed with one of the following sections to learn more 
about working with the backup data using Veeam Explorers: 

 Processing Microsoft Exchange Backups 

 Processing Microsoft SharePoint Backups 

 Processing Microsoft OneDrive Backups 
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Exploring All Organizations 
With this option selected, Veeam will load all backup data for every organization added to the scope and display 
it using a single instance of Veeam Explorer. Each organization will be represented as an independent node in the 
Veeam Explorers navigation pane. 

To explore the backup content created for all organizations added to the scope, do the following: 

1. Go to the Organizations view, right click the root Organizations node, and select either of the 
following options: 

a) Explore latest <product> state of <date>. To explore the latest backup state. 

b) Explore point-in-time state. To select a point-in-time state when the backup was created. 
For more information, see Explore Point-in-time State. 

2. Depending on the data type you are exploring, proceed with one of the following sections to learn more 
about working with the backup data using Veeam Explorers: 

 Processing Microsoft Exchange Backups 

 Processing Microsoft SharePoint Backups 

 Processing Microsoft OneDrive Backups 
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Explore Point-in-time State 
The Explore point-in-time state option allows you to explore your backup content using either the latest 
available backup state, or the particular point-in-time state. When using the latter option, you can select a 
particular date using the calendar control. 

You can also select Show items that have been deleted by user and/or Show all versions of items that 
have been modified by user checkboxes to view historic data.  

To display historic data, Veeam uses other restore points from the repository. Such restore points keep data as 
per the backup date. If items had been deleted or modified by the user prior to the initial execution of a backup 
job or during the execution of a backup job, no historic data will be available. The reason is that the backup 
repository contains the most recent version of a backup file. 

 

Click Finish to launch the corresponding Veeam Explorer. 
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Processing Microsoft Exchange 
Backups 
Proceed with this section if you have selected Microsoft Exchange to explore backups created with Veeam Backup 
for Microsoft Office 365. For more information on how you can explore your backup data, see Exploring Veeam 
Backup for Microsoft Office 365 Backups. 

To learn more about working with Veeam Explorer for Microsoft Exchange, see the following sections: 

 Performing Initial Configuration Settings 

 Getting to Know the User Interface 

 Adding Microsoft Exchange Stores Manually 

 Removing Microsoft Exchange Stores 

 Browsing, Searching and Viewing Items 

 Restoring Organization Mailbox Data 

 Exporting Microsoft Exchange Objects 

 Comparing Microsoft Exchange Items 

 Saving Microsoft Exchange Items 

 Sending Microsoft Exchange Items 
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Performing Initial Configuration Settings 
Before you proceed to work with Veeam Explorer for Microsoft Exchange, you may want to configure the 
application settings as described in the following sections: 

 Enabling Extended Logging 

 Configuring Extensible Storage Engine 

 Configuring SMTP Settings 
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Enabling Extended Logging 
Log files are used to troubleshoot a variety of different situations when certain processes may have gotten the 
unexpected results while being executed. 

By default, logs are collected by using the default mode. In certain cases, you may need to enable the extended 
logging mode to collect logs that contain more details on specific operations. 

To configure extended logging mode, do the following: 

1. Go to the main menu and click the General tab. 

2. Select the Enable Extended logging checkbox. 

3. Go back to the application, perform certain actions and then review the logs to see the details. 
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Configuring Extensible Storage Engine 
To work with database files, Veeam Explorer for Microsoft Exchange requires a special dynamic link library 
ese.dll supplied with Microsoft Exchange.  

The ese.dll file should be of the same version as the Microsoft Exchange application with which the database 
files were created.  

The following versions of Microsoft Exchange are supported: 

 Microsoft Exchange 2016 

 Microsoft Exchange 2013 

 Microsoft Exchange 2010 SP1, SP2 and SP3. 

To specify the path to the ese.dll file, do the following: 

1. Go to the main menu and click the Extensible Storage Engine tab. 

2. Click the link next to the Microsoft Exchange version and specify the path to the ese.dll file.  

The file can be found on a Microsoft Exchange Server distribution CD at 
X:\Setup\ServerRoles\Common\ese.dll, or in the installation directory of the Microsoft Exchange 
server.  

 

To see the estimated size of the Outlook file, select the Show PST size estimation in status bar checkbox. 
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Configuring SMTP Settings 
To send Microsoft Exchange items as attachments, you must configure SMTP server settings. 

To configure the SMTP settings. do the following: 

1. Go to the main menu and click Options. 

2. On the SMTP Settings tab, select the Configure SMTP settings checkbox and specify the following: 

 DNS name or IP address of the mail server. 

 SMTP communication port. 

 The sender email address. This address will appear in the From field when sending OneDrive 
items. See Sending Microsoft Exchange Items. 

 Select Use authentication checkbox If your SMTP server requires SMTP authentication for 
outgoing mail and provide valid credentials. 

 Select Enable SSL security checkbox to enable SSL data encryption. 

3. Click Send to send a test email message. 

4. Click Apply. 
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Getting to Know the User Interface 
Veeam Explorer for Microsoft Exchange provides you with the convenient user interface that allows you to 
perform required operations in a user-friendly manner. 

Main Menu 
The main menu comprises the following features: 

 General Options. Allows you to configure program options. See Performing Initial Configuration 
Settings. 

 Help and Support. 

o Online help. Opens the online web help page. 

o About. Shows current product information. 

 Exit. Closes the program. 
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Main Application Window 
The main application window might be divided into three categories: 

1. The ribbon menu, which contains general program commands organized into logical groups. 

2. The navigation area, which allows you to browse through the hierarchy of your backup files. 

3. The preview pane, which shows you the details about objects you have selected in the navigation area. 

 



 

140 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Adding Microsoft Exchange Stores Manually 
This section explains how you can add Microsoft Exchange stores to the application scope manually 

See the following sections to learn more: 

 Adding Veeam Backup for Office 365 Server 

 Adding Microsoft Exchange Databases 

 Adding Veeam Backup for Microsoft Office 365 Service Provider 
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Adding Veeam Backup for Office 365 Server 
To connect to the Veeam Backup for Office 365 server that stores Microsoft Office 365 organization data, do the 
following: 

1. On the Home tab, click Add Store > Veeam Backup for Office 365 server. You can also right-click 
All Stores node in the navigation pane and select the corresponding context menu command: 

2. Specify connection settings for the Veeam Backup for Microsoft Office 365 server and click Connect. 
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Adding Microsoft Exchange Databases 
To manually add a Microsoft Exchange database file (.edb) to the Veeam Explorer for Microsoft Exchange scope, 
do the following: 

1. On the Home tab, click Add Store > Microsoft Exchange mailbox database. You can also right-
click All Stores in the navigation pane and select the corresponding context menu command.  

2. Click Browse to specify the path to the .edb file and to the Exchange logs folder. 

3. Click Open. 

If the database is in dirty state, a warning message will appear. In this case, you will have to recover your 
database before adding it. 

To recover damaged databases, you must apply transaction logs. Log replay will bring the database to the clear 
state.  

To perform log replay, do the following: 

1. Check Logs folder field and make sure you have specified the correct folder where log files are located. 

2. Click Recover. 

IMPORTANT! 

The account requires the Write permission type to apply transaction logs. 
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Adding Veeam Backup for Microsoft Office 365 
Service Provider 
Veeam Explorer for Microsoft Exchange allows you to add Microsoft Office 365 organization backups that are 
located on server providers servers. 

IMPORTANT! 

The functionality described in this section is only available when both Veeam Explorer for Microsoft Exchange 
and Veeam Backup and Replication solutions are installed on the same machine (either physical or virtual). 

To add Veeam databases containing your backup data, do the following: 

1. From the Start menu, launch Veeam Explorer for Microsoft Exchange. 

2. Click Add Store > Veeam Backup for Microsoft Office 365 Service Provider on the ribbon menu 
or use the corresponding context menu command. 

This option will only be available if you have added at least one service provider. See Adding a Service 
Provider in Veeam Backup & Replication. 

3. In the drop-down menu, select a tenant account to which you want to connect. 

The list of available tenants depends on added service providers. 

4. Provide your Microsoft Office 365 Organization credentials. 

5. Click Connect. 

You can also select a point in time state as of which you want to load an organization database. For more 
information, see Specifying Point in Time. 
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Specifying Point in Time 
When you connect to your service provider server, you may want to select a particular state as of which you 
want to add an organization database to the Veeam Explorer for Microsoft Exchange scope. 

To select a state, do the following: 

1. After you select Veeam Backup for Microsoft Office 365 Service Provider and provide required 
credentials, click Specify point in time. 

2. Specify the point in time state you want to open. 

The following options are available: 

 Use latest available state. Select this option to load the latest backup state. 

 Use the following point in time. Select this option if you want to load a particular state of 
your database. For example, as of a month ago. 

To select a state, use the calendar control. 

3. To load items that have been deleted by the user, select Show items that have been deleted by 
user. 

4. To load all versions of items that have been modified by the user, select Show all versions of items 
that have been modified by user. 
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Removing Microsoft Exchange Stores 
Veeam Explorer for Microsoft Exchange allows you to remove an Exchange store from the application scope 
when you no longer need it. 

To remove a store from the application scope, right-click a store in the navigation pane and select Remove 
Store. 
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Browsing, Searching and Viewing Items 
This section describes how to use the abilities of Veeam Explorer for Microsoft Exchange that allows you to: 

 Browse your backup content 

 View objects properties and open files 

 Search for objects in a backup file 

 Use the advance search capabilities 

Browsing 
To view the content of a backup file, you use the navigation pane which shows you the database structure 
containing your site items such as libraries and subsites. After you select an object in the navigation pane, you 
can see its content in the preview pane. 

In the following figure we have selected the Inbox folder belonging to Mike Wilde. 
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Opening Messages 
To open a message, right-click the document in the preview pane and select Open. 

 

Searching 
The search mechanism allows you to find items matching specified search criteria.  

To search for required items, do the following: 

1. In the navigation pane. select an object where you want to find your data. 

When you select an object, you define the search scope which will be used by Veeam when matching 
search criteria. 

2. Type in your search queue using the search field at the top of the preview pane.  
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NOTE: 

To find the exact phrase, use double quotes. For example, “Office 365”. 

 

You can narrow your search results by specifying various search criteria using the criteria:value format. You can 
also use logical upper-cased operators such as AND, OR and NOT along with wildcard characters such as * and ?. 

Using Advanced Find Capabilities 
The Advanced Find mechanism allows you to define your search criteria more precisely. 

For example, to find messages that contain the 365 substring, do the following: 

1. In the preview pane, select a content node and click Advanced Find. 

2. In the Define search criteria section, select Category > All Mail fields. 

3. In the Field list, select From. 

4. In the Condition list, select Contains. 

5. In the Value field, specify the substring to look for. 

6. Click Start. 
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To remove a filter, click on the cross mark next to it. To remove all configured filters, click Reset. 
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Restoring Organization Mailbox Data 
With Veeam Explorer for Microsoft Exchange, you can quickly recover your organization mailboxes and other 
Exchange related data back to the production environment. 

To learn more about basic principles of recovering Exchange objects, see the following sections: 

 Restoring Folders and Items 

 Restoring Single Mailbox 

 Restoring Multiple Mailboxes 

 Using 1-Click Restore 
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Restoring Single Mailbox 
To restore a mailbox, do the following: 

1. In the navigation pane, select a mailbox you want to restore. 

2. Go to the Mailbox tab and click Restore Mailbox > Restore to. You can also use the corresponding 
mailbox context menu. 

3. Proceed to the Step 1. Specify Credentials section. 

 

Step 1. Specify Credentials 
Specify the account to connect to the target Exchange server.  

You can use your current account or provide another one using either of the following formats: 

 When restoring to the on-premises Exchange server, use the domain\username format. 

 When restoring to the Exchange Online server, use the <username>@<organization>.onmicrosoft.com 
format. 
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Step 2. Specify Target Mailbox Server 
Specify the target mailbox server and a folder to which you want to recover your data.  

You can restore to the original folder or specify a different one. If the specified folder does not exist on the target 
server, it will be created under the root mailbox that is being restored. 

 

Step 3. Specify Restore Options 
Specify the restore options and click Restore to begin the restore process. 
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Excluding Folders 
If you want to prevent some folders from being recovered, click the Exclude folders link and select folders you 
need. 

 

Click OK to save the settings and return to the wizard. 
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Restoring Multiple Mailboxes 
To restore multiple mailboxes, do the following: 

1. In the navigation pane, select the mailbox store that contains required mailboxes. 

2. Go to the Home tab and click Restore Mailboxes. You can also use the corresponding mailbox context 
menu.  

3. Proceed to the Step 1. Specify Credentials section. 

 

Step 1. Specify Credentials 
Depending on the organization type that is being restored, the first step of the credentials dialog will be different: 

 Restoring On-Premises Exchange organizations 

 Restoring Online Exchange organizations 

For On-Premises Exchange 
When restoring to on-premises Exchange server, specify the Global Catalog server name and provide valid access 
credentials. You can use your current account or specify another one in the domain/username format. For more 
information on required permissions, see Required Permissions. 
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For Exchange Online 
When restoring to Exchange Online, specify the account to connect to the target Exchange server. You can use 
your current account or provide another one in the username>@<organization>.onmicrosoft.com format. For 
more information on required permissions, see Required Permissions. 

 

Step 2. Select Mailboxes to Restore 
Select mailboxes you want to restore.  
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To see the corresponding email addresses for each mailbox, click Resolve selected mailboxes. 

Veeam Explorer for Microsoft Exchange can automatically filter Exchange System Mailboxes. Therefore, the 
account under which Veeam Explorer is running should have sufficient rights to access the Active Directory. This 
account can be included in the domain Administrators or Organization Management group or can be 
granted Read permission for the objectClass attribute of the M icrosoft Exchange System Object container.  

NOTE: 

If the account is a member of the Authenticated Users group but the Read permission has not been 
granted, this account will not be able to properly handle Exchange system mailboxes restore. To prevent these 
issues, clear selection for these mailboxes. 

Step 3. Specify Target Mailbox Server 
Specify the target mailbox server and a folder to which you want to recover your data.  

You can restore to the original folder or specify a different one. If the specified folder does not exist on the target 
server, it will be created under the root mailbox that is being restored. 



 

157 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

NOTE: 

This step is only available when restoring data back to On-premises production organizations. 

 

Step 4. Specify Restore Options 
Specify the restore options.  

When restoring multiple mailboxes, you can select the Finish the restore of recent items before restoring 
the remaining items checkbox and instruct the program to Restore items for the last <N> days first. This 
will instruct Veeam Explorer for Microsoft Exchange to restore multiple mailboxes in “chunks”, which means that 
the most recent items in the backup (from the latest N-days interval) will be processed first. Such items become 
available while other items are still being processed in the background. 
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Excluding Folders 
If you want some folders to be excluded from the backup, click the Exclude folders link and select folders you 
want to exclude. 

 

Click OK to save the settings and return to the wizard.   

Click Restore and wait for restore operation to complete. 
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Restoring Folders and Items 
To restore a folder or mailbox item, do the following: 

1. In the navigation pane, select a folder or a mailbox item you want to restore.  

2. Depending on the object you want to restore, click Restore Folder or Restore Items and select 
Restore to. You can also use the corresponding context menu of the object. 

3. Proceed to the Step 1. Specify Credentials section. 
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NOTE: 

If you want to restore In-Place Hold Items and Litigation Hold Items to the original mailbox system folders, 
consider the following limitations: 

• Restore of In-Place Hold Items is not supported for Exchange Server 2013 due to Exchange 
limitations.  

• To restore In-Place Hold Items of Exchange 2016 mailboxes, these mailboxes must have In-Place 
Hold enabled and applied at least once, with DiscoveryHolds system folder creation. Otherwise, 
restore of In-Place Hold Items will fail with an error. For information on enabling In-Place Hold and 
Litigation Hold, see the In-Place Hold and Litigation Hold in Exchange 2016 article. 

• Currently, Veeam Explorer for Microsoft Exchange does not support browsing and restoring items 
from the Versions subfolder of the Recoverable Items folder used by In-Place Hold and Litigation 
Hold to preserve items.  

Step 1. Specify Credentials 
Specify the account to connect to the target Exchange server. 

You can use your current account or provide another one using either of the following formats: 

 When restoring to the on-premises Exchange server, use the domain\username format. 

 When restoring to the Exchange Online server, use the <username>@<organization>.onmicrosoft.com 
format. 

 

Step 2. Specify Target Mailbox Server 
Specify the target mailbox server and a folder to which you want to recover your data.  

You can restore to the original folder or specify a different one. If the specified folder does not exist on the target 
server, it will be created under the root mailbox that is being restored. 

https://technet.microsoft.com/en-us/library/ff637980(v=exchg.160).aspx
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Step 3. Specify Restore Options 
Specify the restore options and click Restore to begin the restore process.  
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Using 1-Click Restore 
You can use 1-Click Restore feature to quickly recover users mailboxes back to the production environment: 

1. In the navigation pane, select a mailbox you want to restore. 

2. Go to the Mailbox tab and click Restore to <original_mailbox_name>. You can also use the 
corresponding context menu command.  

When using 1-Click Restore, Veeam Explorer for Microsoft Exchange recovers objects according to the following:  

• Original Exchange server, original folder and original mailbox name.  

• Both changed and missing items will be restored.  

• Restored items will be marked as unread.  

• No folders will be excluded by default (all folders from the backup will be recovered). 
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Exporting Microsoft Exchange Objects 
With Veeam Explorer for Microsoft Exchange, you can quickly export your organization mailboxes and other 
Exchange related data and save it locally on your computer or over the network as a .pst file. 

To learn more about basic principles of exporting Exchange objects, see the following sections: 

 Using 1-Click Export 

 Export to Custom Location 

 Receiving Export Reports 

IMPORTANT! 
 The export operation is only available if you have a 64-bit version of Microsoft Outlook 2016, 

Microsoft Outlook 2013 or Microsoft Outlook 2010 installed on a computer running Veeam Explorer for 
Microsoft Exchange. 

 To avoid conflicts during the export procedure, exclude .pst files from the indexing scope. 
Sometimes conflicts may occur due to a file, which is used for exporting is being indexed at the 
same time. When exporting to the shared folder, exclude Outlook files or disable Windows Search 
on the destination computer. 
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Exporting to Custom Location 
To export an object to the specified location, do the following: 

1. In the navigation pane, select an object you want to export. 

2. Click Export > Export to .pst file. You can also use the corresponding context menu. 

 

3. Specify the name and location for the .pst file. Click Show Settings if you want to export only those 
items having particular keywords. Veeam Explorer for Microsoft Exchange will check specified keywords 
in all message fields, such as From, To, Subject, and Body. Show Settings feature is not available when 
exporting items. 

 

4. Click Export. 
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Using 1-Click Export 
You can use 1-Click Export feature to quickly export your mailbox data to the .pst file. 

NOTE: 

Export operations require Microsoft Outlook to be installed on a computer running the Veeam Explorer for 
Microsoft Exchange application. 

Exporting Folders 
To export a folder, do the following: 

1. In the navigation pane, select a folder you want to export. 

2. Go to the Folder tab and select Export Folder > Export to 
<default_location>\<original_folder_name>.pst. You can also use the corresponding context 
menu command 
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Exporting Items 
To export an item or multiple items at the same time, do the following: 

1. In the navigation pane, select a folder with required items. 

2. In the preview pane, choose items you want to export. You can also use the Search field to find 
particular items. 

3. Go to the Items tab and select Export Items > Export to 
<default_location>\<original_item_name>.pst. You can also use the corresponding item's 
context menu.  
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Exporting Mailboxes 
To export a mailbox, do the following: 

1. In the navigation pane, select a mailbox you want to export. 

2. Go to the Mailbox tab and select Export mailbox > Export to 
<default_location>\<original_mailbox_name>.pst. You can also use the corresponding mailbox 
context menu. 
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Exporting Mailbox Stores 
To export a mailbox store, or even all stores, do the following: 

1. In the navigation pane, select a store you want to export. 

2. Go to the Home tab and select Export Store > Export to 
<default_location>\<original_store_name>.pst. You can also use the corresponding store's 
context menu command. To export all stores, select All Stores node.  
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Receiving Export Reports 
Veeam Explorer for Microsoft Exchange can deliver detailed reports on export results: 

 To deliver reports to the current user, make sure this user has a valid email address. Also, make sure 
that SMTP Settings are configured properly. See the Configuring Notification Settings section. 

 Having configured email settings for a different user account in Veeam Backup & Replication means that 
this user will also be receiving reports. If you enable these settings during the current Veeam Explorer 
for Microsoft Exchange session, you will need to restart the application in order for the settings to take 
effect. 

 If you want a report to be included in the .pst archive, make sure that the current user email address is 
valid.  

To generate a report, you can use 1-Click export feature or standard export operation.  

The following table comprises fields that would be displayed in the report body. 

Field Description 

Performed by A software component responsible for performing export operation. 

Version Veeam Explorer for Microsoft Exchange build number. To view the build number, go to 
Main Menu and click About. 

Percent complete Total number of items included in the .pst file. Represented in per cents. For example, if 
there are 10 items in a folder and only 6 of them have been exported due to some search 
criteria, this value will be 60%. If the whole folder was exported, it will be 100%. 

Started by Export initiator or current user account running Veeam Explorer for Microsoft Exchange. 

Start time, End time Report generation start and end time, respectively. 

Root The relative path to the object within the mail database from which data was exported. In 
the example, shown in the figure above, this is MBase01.edb\MB01\Drafts, that is, the 
Drafts folder in the mailbox MB01 of the MBase01.edb mail database. 

Path The full path to the exported .pst file. 

Export type Depending on the export scope, the following types are available: 

• All items.  The whole container that was selected for 1-click or regular export. 
• Selected items. One or several selected items. 
• Search results (only for regular export). This type occurs only if you select 

Export to .pst  and then in the Export dialog click Show settings and 
select the Save only items containing keywords. 

Stores Datastores that contain exported items. 

Mailboxes to search A mailbox(es) that contains exported items. If you select the whole datastore as a root 
object, all mailboxes in that datastore will be reported in this field.  

http://helpcenter.veeam.com/backup/vsphere/general_email_notifications.html
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Mailboxes searched 
successfully, Mailboxes not 
searched successfully 

Results for Mailboxes to search. 

Size Total size of exported items. 

Items The number of exported items. 

Errors The number of errors that occurred during the export. 

When exporting search results only, consider the following: 

 The report will be entitled Email export completed partially. 

 The Percent complete field will contain the corresponding value, depending on how many items from 
the search scope matched the search keywords. 

 The last field in the report will be Keyword hits. It will include the table containing: 

o Keyword. Search criteria. 

o Hits. The number of exported items that matched the search keywords. 

o Mailboxes. The number of mailboxes comprising the search scope. 
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Comparing Microsoft Exchange Items 
Veeam Explorer for Microsoft Exchange allows you to compare objects in the backup file with that of a production 
environment state. 

To compare objects, do the following: 

1. Select an object you want to compare and click Compare with Production on the ribbon menu. 

2. Proceed with the Step 1. Specify Credentials section to authorize yourself in your production 
organizations. 

 

3. After the authorization process is complete, click Show Changed Items Only on the toolbar to view 
only those items that have been changed. 
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4. To view details on what exactly has changed since the last backup, right-click an item in the preview 
pane and select Compare item properties.  

The discrepancies will be shown in the Compare Message Properties window. If both objects are 
equal, nothing will be displayed. 

To show unchanged objects, select Show unchanged properties at the top-right corner. To show system 
properties, select Show system properties. 

Double-click Body to see the body message. 
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NOTE: 

To compare a single item, right-click an item and select Compare item properties without using the 
Compare with Production option. 
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Step 1. Specify Credentials 
Provide credentials to access the production environment of an organization that contains data to which you 
want to compare your current backup state. 

Depending on the organization type, the first step of the credentials dialog will be different: 

 Comparing with On-Premises Exchange organizations 

 Comparing with Online Exchange organizations 

For On-Premises Exchange 
When comparing with on-premises Exchange organizations, specify the Global Catalog server name and valid 
access credentials. For more information on required permissions, see Required Permissions. 
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For Exchange Online 
When comparing with Exchange Online organizations, specify the account to connect to the target Exchange 
server. You can use your current account or provide another one in the 
<username>@<organization>.onmicrosoft.com format. 

 



 

176 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Step 2. Specify Target Mailbox Server 
Specify the target mailbox server (CAS). 

NOTE: 

This step is only available when comparing data with your On-premises organizations. 
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Saving Microsoft Exchange Items 
Veeam Explorer for Microsoft Exchange allows you to save any items as Microsoft Exchange Mail Document 
(.msg) files. 

To save your Exchange data, do the following: 

1. In the navigation pane select a folder containing required items. 

2. In the preview pane, choose items you want to save. You can also use the Search field to find particular 
items. 

3. Go to the Items tab and click Save Items > Save to <folder_name>. You can also use the 
corresponding context menu command. A <folder_name> name depends on the latest location that 
was used when saving items. By default, files will be saved with the same name as the subject of the 
mail item. 

 

Saving to Custom Location 
To save an item to a custom location, do the following: 

1. Select a folder in the navigation tree and in the preview pane, choose item(s) you want to save. You can 
also use the Search field to find particular items. 

2. On the Items tab, click Save Items > Save to .msg file, or use the corresponding item's context 
menu. 
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3. Specify the location and click OK. 
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Sending Microsoft Exchange Items 
Veeam Explorer for Microsoft Exchange allows you to send your Exchange items to the specified recipients. 
Before sending your documents, ensure that you have configured your SMTP settings properly. For more 
information, see Configuring SMTP Settings. 

To send items, do the following: 

1. In the navigation pane select the folder containing required items. 

2. In the preview pane, choose items you want to send. You can also use the Search field to find particular 
items. 

3. Go to the Items tab and click Send Items > Send to. You can also use the corresponding item's 
context menu. 

  

4. To edit the message text, click More details. Click Send to send an email. 
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An email address in the From field will be automatically added based on the address you have specified during 
configuring SMTP Settings in the Veeam Explorer for Microsoft Exchange Options dialog.  

The recipient address will be obtained using Active Directory records. If resolved successfully, a recipient address 
will be added to the To field. Otherwise, as well as if you have selected to send items from different mailboxes, 
Veeam Explorer for Microsoft Exchange will put the same address in both From and To fields.  

You can also specify the email address manually. In the Send To dialog you can edit the subject and the 
message text. A default subject is Mail Items Recovery. 

You can double-click the attachment to see its content. You can also see the message headers by clicking the 
corresponding link at the top-right area of the message window. 

NOTE: 
 If SMTP Settings have not been configured, Veeam will notify you that your SMTP Server is not yet 

specified. To know how to configure SMTP Settings, see Performing Initial Configuration Settings. 
 The maximum amount of data that you would be able to send depends on your SMTP server 

configuration settings. 

https://helpcenter.veeam.com/docs/backup/explorers/vee_configuring.html?ver=95
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Processing Microsoft SharePoint 
Backups 
Proceed with this section if you have selected Microsoft SharePoint to explore backups created with Veeam 
Backup for Microsoft Office 365. For more information on how you can explore your backup data, see Exploring 
Veeam Backup for Microsoft Office 365 Backups. 

The following versions of Microsoft SharePoint are supported: 

 Microsoft SharePoint 2010 

 Microsoft SharePoint 2013 

 Microsoft SharePoint 2016 

 Microsoft SharePoint Online 

To learn more about working with Veeam Explorer for Microsoft SharePoint, see the following sections: 

 Performing Initial Configuration Settings 

 Getting to Know the User Interface 

 Adding Microsoft SharePoint Databases Manually 

 Removing Microsoft SharePoint Databases 

 Browsing, Searching and Viewing Items 

 Restoring Microsoft SharePoint Document Libraries and Lists 

 Restoring Microsoft SharePoint Documents and List Items 

 Restoring Microsoft SharePoint Sites 

 Saving Microsoft SharePoint Documents and Libraries and Sending Microsoft SharePoint Documents and 
Libraries 
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Performing Initial Configuration Settings 
Before you proceed to work with Veeam Explorer for Microsoft SharePoint, you may want to configure the 
application settings as described in the following sections: 

 Configuring SQL Server Settings 

 Configuring Custom Lists 

 Configuring SMTP Settings 

 Enabling Extended Logging 
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Configuring SQL Server Settings 
Veeam Explorer requires a Microsoft staging SQL server to be able to perform Microsoft SharePoint item recovery 
and configure custom lists templates for SQL server databases. 

Consider the following when configuring a staging SQL server: 

 If a SQL server belongs to an untrusted domain, connection will not be possible. 

 If a SQL server belongs to a trusted domain, only SQL Server authentication method will be available. 

 If a SQL server belongs to the same domain as the machine where Veeam Explorer is running, then both 
Windows and SQL Server authentication methods are available. 

In this case, if you plan to use Windows authentication, you will need to configure the delegation 
settings: 

a) In Active Directory Users and Computers, select the necessary staging SQL server. 

b) Open its properties and select the Delegation tab. Select Trust this computer for 
delegation to specified services only and Use any authentication protocol options for 
the cifs service on a computer with Veeam Explorer. 

c) Restart the staging SQL Server. 

d) Select a user account to connect to the staging SQL Server. Also, select its properties on the 
Account tab and make sure the Account is sensitive and cannot be delegated check box 
is cleared. 

To configure SQL server settings, do the following: 

1. Go to the main menu and click Options. 

2. On the SQL Server settings tab, specify the following: 

 The SQL Server name. You can click Browse and select either Local or Network server. 

 Specify the user account to connect to the SQL server. When configuring local staging server, 
you can use your current account or specify another one. When configuring a remote staging 
server, only the Use the following account option will be available. 
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Configuring Custom Lists 
Veeam Explorer for Microsoft SharePoint supports obtaining custom list templates from Veeam Backup for 
Microsoft Office 365 backup files. The actual information about the templates is stored in your backup files and 
obtained automatically so that you can view the custom list data without having to perform any additional 
operations.  

The total number of existing templates as per the corresponding SharePoint server is available under the 
STATUS column. The SHAREPOINT SERVER column contains the Microsoft SharePoint server name. 

To be notified if the database contains new templates other than those you already have, select the Warn me if 
attached database has new custom list templates checkbox. 

 

To see the templates with their corresponding names and features, click the link under the STATUS column.  

See the figure below showing you what custom list templates are available. 
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 To remove templates, click Clear. 

Importing Templates Manually 
To import existing templates from the Microsoft SharePoint server manually, do the following: 

1. Go to the main menu, select Options > Custom Lists and click Update. 

2. Specify the path to Microsoft SharePoint templates, select the language and click OK. The language set 
in the drop-down list depends on the installed language packages on a SharePoint server. 

 

Importing Templates Using Ribbon Menu 

NOTE: 

Available only for Microsoft SQL Server databases and requires a staging SQL server. For more information on 
configuring a staging server, see Configuring SQL Server Settings. 

To import existing templates from the Microsoft SharePoint server using the ribbon menu, do the following: 

1. In the navigation pane, select a SQL database. 

2. Click Custom List Template on the ribbon menu, or right-click a SQL database and select Custom list 
templates settings. 
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3. Choose how you want your templates to be applied to your databases: 

a) Select Use global custom list settings to apply the templates to all databases added to the 
application scope. 

b) Select Use the following custom list settings to apply the templates to the selected 
database only. 

When using the latter option, specify the path to the Microsoft SharePoint templates, select the 
language and click OK. The language set in the drop-down list depends on the installed 
language packages on a SharePoint server. 
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Configuring SMTP Settings 
To send Microsoft SharePoint items as attachments, you must configure SMTP server settings. 

To configure the SMTP settings. do the following: 

1. Go to the main menu and click Options. 

2. On the SMTP Settings tab, select the Configure SMTP settings checkbox and specify the following: 

 DNS name or IP address of the mail server. 

 SMTP communication port. 

 The sender email address. This address will appear in the From field when sending OneDrive 
items. See Sending Microsoft SharePoint Documents and Libraries. 

 Select Use authentication checkbox If your SMTP server requires SMTP authentication for 
outgoing mail and provide valid credentials. 

 Select Enable SSL security checkbox to enable SSL data encryption. 

3. Click Send to send a test email message. 

4. Click Apply. 
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Enabling Extended Logging 
Log files are used to troubleshoot a variety of different situations when certain processes may have gotten the 
unexpected results while being executed. 

By default, logs are collected by using the default mode. In certain cases, you may need to enable the extended 
logging mode to collect logs that contain more details on specific operations. 

To configure extended logging mode, do the following: 

1. Go to the main menu and click the General tab. 

2. Select the Enable Extended logging checkbox. 

3. Go back to the application, perform certain actions and then review the logs to see the details. 
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Getting to Know the User Interface 
Veeam Explorer for Microsoft SharePoint provides you with the convenient user interface that allows you to 
perform required operations in a user-friendly manner. 

Main Menu 
The main menu comprises the following features: 

 General Options. Allows you to configure program options. See Performing Initial Configuration 
Settings. 

 Help and Support. 

o Online help. Opens the online web help page. 

o About. Shows current product information. 

 Exit. Closes the program. 
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Main Application Window 
The main application window might be divided into three categories: 

1. The ribbon menu, which contains general program commands organized into logical groups. 

2. The navigation area, which allows you to browse through the hierarchy of your backup files. 

3. The preview pane, which shows you the details about objects you have selected in the navigation area. 
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Adding Microsoft SharePoint Databases 
Manually 
This section explains how you can add Microsoft SharePoint databases to the application scope manually 

See the following sections to learn more: 

 Adding Microsoft SharePoint Databases 

 Adding Veeam Backup for Microsoft Office 365 Databases 

 Adding Veeam Backup for Microsoft Office 365 Server 

 Adding Veeam Backup for Microsoft Office 365 Service Provider 
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Adding Microsoft SharePoint Databases 
To manually add new Microsoft SharePoint databases to the application scope, do the following: 

1. Click Add Database > Microsoft SharePoint Databases on the ribbon menu or use the 
corresponding context menu command. 

2. Specify the location of the Microsoft SharePoint primary content database file (.mdf).  

The corresponding secondary database and the transaction log file (.ldf) will also be added. To add a 
remote BLOB (binary large objects) stores (RBS), click Add next to the Remote BLOB Stores section. 

3. Click OK. 
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Adding Veeam Backup for Microsoft Office 365 
Databases 
To manually add databases that store Microsoft Office 365 organization data, do the following: 

1. Click Add Database > Veeam Backup for Microsoft Office 365 Databases on the ribbon menu or 
use the corresponding context menu command. 

2. Specify the database file location and the log directory. 

3. Click Open. 

 

NOTE: 

Make sure you have disabled the Veeam Backup Proxy for Microsoft Office 365 service when adding 
local databases. You can stop this service by using the services.msc console. If you try to add a database 
having this service still in progress, you will receive an error message and will not be able to access the 
database due to database lock. 
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Adding Veeam Backup for Microsoft Office 365 
Server 
You can use the in-built Veeam Explorer abilities to connect to another Veeam Backup for Microsoft Office 365 
server and add its databases to the Veeam Explorer for Microsoft SharePoint scope. 

To connect to another Veeam Backup for Microsoft Office 365 server remotely, do the following: 

1. Click Add Database > Veeam Backup for Microsoft Office 365 Server on the ribbon menu or use 
the corresponding context menu command. 

2. Specify the server name or its IP-address, port, and the valid credentials. Click Connect. 
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Adding Veeam Backup for Microsoft Office 365 
Service Provider 
Veeam Explorer for Microsoft SharePoint allows you to add Microsoft Office 365 organization backups that are 
located on server providers servers. 

IMPORTANT! 

The functionality described in this section is only available when both Veeam Explorer for Microsoft SharePoint 
and Veeam Backup and Replication solutions are installed on the same machine (either physical or virtual). 

To add Veeam databases containing your backup data, do the following: 

1. From the Start menu, launch Veeam Explorer for Microsoft SharePoint. 

2. Click Add Database > Veeam Backup for Microsoft Office 365 Service Provider on the ribbon 
menu or use the corresponding context menu command. 

This option will only be available if you have added at least one service provider. See Adding a Service 
Provider in Veeam Backup & Replication. 

3. In the drop-down menu, select a tenant account to which you want to connect. 

The list of available tenants depends on added service providers. 

4. Provide your Microsoft Office 365 Organization credentials. 

5. Click Connect. 

You can also select a point in time state as of which you want to load an organization database. For more 
information, see Specifying Point in Time. 
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Specifying Point in Time 
When you connect to your service provider server, you may want to select a particular state as of which you 
want to add an organization database to the Veeam Explorer for Microsoft SharePoint scope. 

To select a state, do the following: 

1. After you select Veeam Backup for Microsoft Office 365 Service Provider and provide required 
credentials, click Specify point in time. 

2. Specify the point in time state you want to open. 

The following options are available: 

 Use latest available state. Select this option to load the latest backup state. 

 Use the following point in time. Select this option if you want to load a particular state of 
your database. For example, as of a month ago. 

To select a state, use the calendar control. 

3. To load items that have been deleted by the user, select Show items that have been deleted by 
user. 

4. To load all versions of items that have been modified by the user, select Show all versions of items 
that have been modified by user. 
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Removing Microsoft SharePoint Databases 
Veeam Explorer for Microsoft SharePoint allows you to remove a Microsoft SharePoint database from the 
application scope when you no longer need it. 

To remove a database from the application scope, right-click a database in the navigation pane and select 
Remove Database. 
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Browsing, Searching and Viewing Items 
This section describes how to use the abilities of Veeam Explorer for Microsoft SharePoint that allows you to: 

 Browse your backup content 

 View objects properties and open files 

 Search for objects in a backup file 

 Use the advance search capabilities 

Browsing 
To view the content of a backup file, you use the navigation pane which shows you the database structure 
containing your site items such as libraries and subsites. After you select an object in the navigation pane, you 
can see its content in the preview pane. 

In the following figure we have selected the Style Library belonging to Arron Brown. 

 

Viewing Properties and Opening Files 
To view object properties, right-click an object in the preview pane and select View Properties. To open a 
document using an associated application, right-click the document in the preview pane and select Open. 
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Searching 
The search mechanism allows you to find items matching specified search criteria.  

To search for required items, do the following: 

1. In the navigation pane. select an object where you want to find your data. 

When you select an object, you define the search scope which will be used by Veeam when matching 
search criteria. 

2. Type in your search queue using the search field at the top of the preview pane.  
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NOTE: 

To find the exact phrase, use double quotes. For example, “media player”. 

 

You can narrow your search results by specifying various search criteria using the criteria:value format.  

For example, to find all items that require approval in the list of decisions, you can use the following search 
query: status:pending approval. You can also use logical upper-cased operators such as AND, OR and NOT along 
with wildcard characters such as * and ?. The search criteria are similar to those used for searching in Microsoft 
SharePoint. For more information, see this Microsoft article. 

Using Advanced Find Capabilities 
The Advanced Find mechanism allows you to define your search criteria more precisely. 

For example, to find an object that starts with the word Media, do the following: 

1. In the preview pane, select a content node and click Advanced Find. 

2. In the Define search criteria section, select Category > Document fields. 

3. In the Field list, select File Name. 

4. In the Condition list, select Starts With. 

5. In the Value field, specify the file name. 

6. Click Start. 

http://office.microsoft.com/en-us/sharepoint-server-help/search-for-content-HA010378166.aspx?CTT=1#BM4
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To remove a filter, click on the cross mark next to it. To remove all configured filters, click Reset. 
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Restoring Microsoft SharePoint Document 
Libraries and Lists 
Veeam Explorer for Microsoft SharePoint allows you to recover Microsoft SharePoint document libraries and lists. 

To perform the recovery, do the following: 

1. In the navigation pane, select a library or a list. 

2. Click Restore Library or Restore List respectively on the ribbon menu or use the corresponding 
context menu commands. 

3. Proceed to the Step 1. Specify Credentials section. 

 

IMPORTANT! 

To restore your Microsoft SharePoint document libraries and lists from Microsoft SQL databases, ensure that 
both Veeam Explorer for Microsoft SharePoint and Veeam Backup and Replication Update 3 or higher are 
installed on the same machine (either physical or virtual). Otherwise, Microsoft SQL databases restore will not 
be possible. Another condition is that the Veeam Backup and Replication solution must have the Enterprise or 
Enterprise Plus license. 
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Step 1. Specify Credentials 
When recovering your Microsoft SharePoint document libraries and lists, the first step of the restore process will 
be the credentials step, where you must provide valid credentials to access your production organizations. 

The credentials dialog is different for every database type you are restoring from. For more information refer to 
the following subsections: 

 Restoring Office 365 organizations 

 Restoring On-premises Exchange and SharePoint organizations 

 Restoring from Microsoft SQL database 

Restoring Office 365 Organizations Data 
Specify credentials to access your Microsoft Office 365 organization and click Next. 
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Restoring On-premises Exchange and SharePoint 
Organizations 
Specify credentials to access your Microsoft Exchange or SharePoint organization and click Next. 

 

Restoring from Microsoft SQL Database 
When recovering your data from a Microsoft SQL database, provide the following: 

 The site URL to which you want to recover your site. 

 The appropriate credentials to access your production environment. 

NOTE: 

When recovering Microsoft SharePoint sites from a Microsoft SQL database, you will be taken directly to Step 
3. Specify the Restore Option bypassing Step 2. Specify the Target Site. 
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Step 2. Specify Target List 
Specify whether items should be restored to the original list, or choose another one. Click Next. 

If either the document library, or list that is being restored does not exist, Veeam will create one automatically. 
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Step 3. Specify Restore Options 
Specify the restore options and click Restore. 

The restore options are as follows: 

 Changed items. Allows you to recover data that has been modified in your production environment. 

 Missed items. Allows you to recover missed items. 

 Restore permissions. Allows you to recover permissions. If not selected, the permissions for the 
recovered document library or list will be set as follows: 

o If the library (or list) does not exist on target, it will be created inheriting permissions from the 
parent object. 

o If the library (or list) already exists on target, permissions will be preserved. 

 Restore list view. Allows you to recover your list views. 

 History restore options. Allows you to select version to recover: 

o Overwrite. To overwrite data in the production environment by recovering all versions from 
the backup. 

o Merge. To restore only the latest version of the document. 

If not selected all versions in the production environment will be replaced with the corresponding data 
from a backup file. 
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Restoring Microsoft SharePoint Documents 
and List Items 
Veeam Explorer for Microsoft SharePoint allows you to recover Microsoft SharePoint documents and list items. 

To perform the recovery, do the following: 

1. In the navigation pane, select a document or a list item. 

2. Click Restore Document or Restore Item respectively on the ribbon menu or use the corresponding 
context menu commands. 

3. Proceed to the Step 1. Specify Credentials section. 

 

IMPORTANT! 

To restore your Microsoft SharePoint documents and list Items from Microsoft SQL databases, ensure that 
both Veeam Explorer for Microsoft SharePoint and Veeam Backup and Replication Update 3 or higher are 
installed on the same machine (either physical or virtual). Otherwise, Microsoft SQL databases restore will not 
be possible. Another condition is that the Veeam Backup and Replication solution must have the Enterprise or 
Enterprise Plus license. 
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Step 1. Specify Credentials 
When recovering your Microsoft SharePoint documents and list Items, the first step of the restore process will be 
the credentials step, where you must provide valid credentials to access your production organizations. 

The credentials dialog is different for every database type you are restoring from. For more information refer to 
the following subsections: 

 Restoring Office 365 organizations 

 Restoring On-premises Exchange and SharePoint organizations 

 Restoring from Microsoft SQL database 

Restoring Office 365 Organizations Data 
Specify credentials to access your Microsoft Office 365 organization and click Next. 

 

Restoring On-premises Exchange and SharePoint 
Organizations 
Specify credentials to access your Microsoft Exchange or SharePoint organization and click Next. 
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Restoring from Microsoft SQL Database 
When recovering your data from a Microsoft SQL database, provide the following: 

 The site URL to which you want to recover your site. 

 The appropriate credentials to access your production environment. 

NOTE: 

When recovering Microsoft SharePoint sites from a Microsoft SQL database, you will be taken directly to Step 
3. Specify the Restore Option bypassing Step 2. Specify the Target Site. 
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Step 2. Specify Target List 
Specify whether items should be restored to the original list, or choose another one. Click Next. 

NOTE: 

When restoring documents or lists, consider that both must be presented in your production environment. If 
either does not exist, restore will fail. 

 

 



 

212 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Step 3. Specify Restore Options 
Specify the restore options and click Restore. 

The restore options are as follows: 

 Changed items. Allows you to recover data that has been modified in your production environment. 

 Missed items. Allows you to recover missed items. 

 Restore permissions. Allows you to recover permissions. If not selected, permissions for the recovered 
document library or list will be set as follows: 

o If the library (or list) does not exist on target, it will be created inheriting permissions from the 
parent object 

o If the library (or list) already exists on target, permissions will be preserved 

 History restore options. Allows you to select restore options such as: 

o Overwrite. To overwrite data in the production environment by recovering all versions from 
the backup. 

o Merge. To restore only the latest version of the document. 

If not selected all versions in the production environment will be replaced with the corresponding data 
from a backup file. 
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Restoring Microsoft SharePoint Sites 
To perform SharePoint sites recovery, do the following: 

1. In the navigation pane, select a site you want to recover. 

2. Click Restore Site on the ribbon menu or use the corresponding context menu command. 

3. Proceed to the Step 1. Specify Credentials section. 

 

IMPORTANT! 

To restore your Microsoft SharePoint sites from Microsoft SQL databases, ensure that both Veeam Explorer for 
Microsoft SharePoint and Veeam Backup and Replication Update 3 or higher are installed on the same 
machine (either physical or virtual). Otherwise, Microsoft SQL databases restore will not be possible. Another 
condition is that the Veeam Backup and Replication solution must have the Enterprise or Enterprise Plus 
license. 
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Step 1. Specify Credentials 
When recovering your Microsoft SharePoint sites, the first step of the restore process will be the credentials step, 
where you must provide valid credentials to access your production organizations. 

The credentials dialog is different for every database type you are restoring from. For more information refer to 
the following subsections: 

 Restoring Office 365 organizations 

 Restoring On-premises Exchange and SharePoint organizations 

 Restoring from Microsoft SQL database 

Restoring Office 365 Organizations Data 
Specify credentials to access your Microsoft Office 365 organization and click Next. 

 

Restoring On-premises Exchange and SharePoint 
Organizations 
Specify credentials to access your Microsoft Exchange or SharePoint organization and click Next. 
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Restoring from Microsoft SQL Database 
When recovering your data from a Microsoft SQL database, provide the following: 

 The site URL to which you want to recover your site. 

 The appropriate credentials to access your production environment. 

NOTE: 

When recovering Microsoft SharePoint sites from a Microsoft SQL database, you will be taken directly to Step 
3. Specify the Restore Option bypassing Step 2. Specify the Target Site. 
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Step 2. Specify Target Site 
Specify whether the selected site should be restored to the original location, or choose a site alias you want to 
use. 

 

NOTE: 

This step is unavailable when recovering your Microsoft SharePoint sites from a Microsoft SQL database. 
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Step 3. Specify Restore Options 
Specify the restore options and click Restore. 

The restore options are as follows: 

 Changed items. Allows you to recover data that has been modified in your production environment. 

 Missed items. Allows you to recover missed items. 

 Restore permissions. Allows you to recover permissions. If not selected, permissions will be inherited 
from the parent site. 

 Restore subsites. Allows you to recover subsites. If not selected, sites that are being restored will 
contain only document libraries and lists. 

 History restore options. Allows you to select version to recover: 

o Overwrite. To overwrite data in the production environment by recovering all versions from 
the backup. 

o Merge. To restore only the latest version of the document. 

If not selected all versions in the production environment will be replaced with the corresponding data 
from a backup file. 

 



 

218 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Saving Microsoft SharePoint Documents 
and Libraries 
Veeam Explorer for Microsoft SharePoint allows you to save your libraries and library documents to the specified 
location. 

To save a Microsoft SharePoint library or library documents, do the following: 

1. In the navigation pane, select a library. 

2. Click Save Library > Save files or Save Library > Save as ZIP on the ribbon menu to save the 
entire library. The Save as ZIP option allows you to save your library as a ZIP archive.  

To save library documents, select required documents in the preview pane and click Save Document > 
Save files or Save Document > Save as ZIP. 
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Sending Microsoft SharePoint Documents 
and Libraries 
Veeam Explorer for Microsoft SharePoint allows you to send your libraries or library items to the specified 
recipients. Before sending your documents, ensure that you have configured your SMTP settings properly. For 
more information, see Configuring SMTP Settings. 

To send Microsoft SharePoint library or library items, do the following: 

1. In the navigation pane, select the library that contains items you want to send. 

2. Click Send Library on the ribbon menu to send the entire library. You may also want to send particular 
items in a library by selecting required items in the preview pane and clicking Send Document. You can 
also use the corresponding context menu commands. 

 

3. Provide the recipient address. The From filed address will be added automatically based on the address 
you have provided during configuring SMTP settings. Items will be sent as attachments. To edit the 
message body, click More Details. 



 

220 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

 

NOTE: 

The maximum amount of data that you would be able to send depends on your SMTP server configuration 
settings. 
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Processing Microsoft OneDrive 
Backups 
Proceed with this section if you have selected Microsoft OneDrive to explore backups created with Veeam Backup 
for Microsoft Office 365. For more information on how you can explore your backup data, see Exploring Veeam 
Backup for Microsoft Office 365 Backups. 

To learn more about working with Veeam Explorer for Microsoft OneDrive for Business, see the following 
sections: 

 Performing Initial Configuration Settings 

 Getting to Know the User Interface 

 Adding Microsoft OneDrive Databases Manually 

 Removing Organizations 

 Browsing, Searching and Viewing Items 

 Restoring Microsoft OneDrive Data 

 Copying Microsoft OneDrive Documents 

 Saving Microsoft OneDrives 

 Saving Microsoft OneDrive Documents and Folders 

 Sending Microsoft OneDrive Documents 
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Performing Initial Configuration Settings 
Before you proceed to work with Veeam Explorer for Microsoft OneDrive for Business, you may want to configure 
the application settings as described in the following sections: 

 Enabling Extended Logging 

 Configuring SMTP Settings 
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Enabling Extended Logging 
Log files are used to troubleshoot a variety of different situations when certain processes may have gotten the 
unexpected results while being executed. 

By default, logs are collected by using the default mode. In certain cases, you may need to enable the extended 
logging mode to collect logs that contain more details on specific operations. 

To configure extended logging mode, do the following: 

1. Go to the main menu and select the General tab. 

2. On the General tab select the Enable Extended logging checkbox. 

3. Go back to the application, perform certain actions and then review the logs to see the details. 
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Configuring SMTP Settings 
To send Microsoft OneDrive items as attachments, you must configure SMTP server settings. 

To configure the SMTP settings. do the following: 

1. Go to the main menu and click Options. 

2. On the SMTP Settings tab, select the Configure SMTP settings checkbox and specify the following: 

 DNS name or IP address of the mail server. 

 SMTP communication port. 

 The sender email address. This address will appear in the From field when sending OneDrive 
items. See Sending Microsoft OneDrive Documents. 

 Select Use authentication checkbox If your SMTP server requires SMTP authentication for 
outgoing mail and provide valid credentials. 

 Select Enable SSL security checkbox to enable SSL data encryption. 

3. Click Send to send a test email message. 

4. Click Apply. 

 



 

225 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Getting to Know the User Interface 
Veeam Explorer for Microsoft OneDrive for Business provides you with the convenient user interface that allows 
you to perform required operations in a user-friendly manner. 

Main Menu 
The main menu comprises the following features: 

 General Options. Allows you to configure program options. See Performing Initial Configuration 
Settings. 

 Help and Support. 

o Online help. Opens the online web help page. 

o About. Shows current product information. 

 Exit. Closes the program. 
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Main Application Window 
The main application window might be divided into three categories: 

1. The ribbon menu, which contains general program commands organized into logical groups. 

2. The navigation area, which allows you to browse through the hierarchy of your backup files. 

3. The preview pane, which shows you the details about objects you have selected in the navigation area. 
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Adding Microsoft OneDrive Organizations 
Manually 
This section explains how you can add Microsoft OneDrive organizations to the application scope manually 

See the following sections to learn more: 

 Adding Veeam Backup for Microsoft Office 365 Databases 

 Adding Veeam Backup for Microsoft Office 365 Server 

 Adding Veeam Backup for Microsoft Office 365 Service Provider 
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Adding Veeam Backup for Microsoft Office 365 
Databases 
To manually add databases that store Microsoft Office 365 organization data, do the following: 

1. Click Add Org > Veeam Backup for Microsoft Office 365 Databases on the ribbon menu or use 
the corresponding context menu command. 

2. Specify the database file location and the log directory.  

3. Click Open. 

 

NOTE: 

Make sure you have disabled the Veeam Backup Proxy for Microsoft Office 365 service when adding 
local databases. You can stop this service by using the services.msc console. If you try to add a database 
having this service still in progress, you will receive an error message and will not be able to access the 
database due to database lock. 
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Adding Veeam Backup for Microsoft Office 365 
Server 
You can use the in-built Veeam Explorer abilities to connect to another Veeam Backup for Microsoft Office 365 
server and add its databases to the Veeam Explorer for Microsoft OneDrive for Business scope. 

To connect to another Veeam Backup for Microsoft Office 365 server remotely, do the following: 

1. Click Add Org > Veeam Backup for Microsoft Office 365 Server on the ribbon menu or use the 
corresponding context menu command. 

2. Specify the server name or its IP-address, port, and the valid credentials. Click Connect. 
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Adding Veeam Backup for Microsoft Office 365 
Service Provider 
Veeam Explorer for Microsoft OneDrive for Business allows you to add Microsoft Office 365 organization backups 
that are located on server providers servers. 

IMPORTANT! 

The functionality described in this section is only available when both Veeam Explorer for Microsoft OneDrive 
for Business and Veeam Backup and Replication solutions are installed on the same machine (either physical 
or virtual). 

To add Veeam databases containing your backup data, do the following: 

1. From the Start menu, launch Veeam Explorer for Microsoft OneDrive for Business. 

2. Click Add Org > Veeam Backup for Microsoft Office 365 Service Provider on the ribbon menu or 
use the corresponding context menu command. 

This option will only be available if you have added at least one service provider. See Adding a Service 
Provider in Veeam Backup & Replication. 

3. In the drop-down menu, select a tenant account to which you want to connect. 

The list of available tenants depends on added service providers. 

4. Provide your Microsoft Office 365 Organization credentials. 

5. Click Connect. 

You can also select a point in time state as of which you want to load an organization database. For more 
information, see Specifying Point in Time. 
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Specifying Point in Time 
When you connect to your service provider server, you may want to select a particular state as of which you 
want to add an organization database to the Veeam Explorer for Microsoft OneDrive for Business scope. 

To select a state, do the following: 

1. After you select Veeam Backup for Microsoft Office 365 Service Provider and provide required 
credentials, click Specify point in time. 

2. Specify the point in time state you want to open. 

The following options are available: 

 Use latest available state. Select this option to load the latest backup state. 

 Use the following point in time. Select this option if you want to load a particular state of 
your database. For example, as of a month ago. 

To select a state, use the calendar control. 

3. To load items that have been deleted by the user, select Show items that have been deleted by 
user. 

4. To load all versions of items that have been modified by the user, select Show all versions of items 
that have been modified by user. 
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Removing Organizations  
Veeam Explorer for Microsoft OneDrive for Business allows you to remove an organization from the application 
scope when you no longer need it. 

To remove an organization from the application scope, right-click an organization in the navigation pane and 
select Remove organization. 
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Browsing, Searching and Viewing Items 
This section describes how to use the abilities of Veeam Explorer for Microsoft OneDrive for Business that allows 
you to: 

 Browse your backup content 

 View objects properties and open files 

 Search for objects in a backup file 

 Use the advance search capabilities 

Browsing 
To view the content of a backup file, you use the navigation pane which shows you the database structure 
containing your OneDrive documents. After you select an object in the navigation pane, you can see its content 
in the preview pane. 

In the following figure we have selected the Attachment folder belonging to David Low. 

 

Viewing Properties and Opening Files 
To view object properties, right-click an object in the preview pane and select View Properties. To open a 
document using an associated application, right-click the document in the preview pane and select Open. 
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Searching 
The search mechanism allows you to find items matching specified search criteria.  

To search for required items, do the following: 

1. In the navigation pane. select an object where you want to find your data. 

When you select an object, you define the search scope which will be used by Veeam when matching 
search criteria. 

2. Type in your search queue using the search field at the top of the preview pane.  



 

235 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

NOTE: 

To find the exact phrase, use double quotes. For example, “Attachments”. 

 

You can narrow your search results by specifying various search criteria using the criteria:value format. You can 
also use logical upper-cased operators such as AND, OR and NOT along with wildcard characters such as * and ?.  

Using Advanced Find Capabilities 
The Advanced Find mechanism allows you to define your search criteria more precisely. 

For example, to find an object that starts with the word Attachme, do the following: 

1. In the preview pane, select a content node and click Advanced Find. 

2. In the Define search criteria section, select Category > Document fields. 

3. In the Field list, select File Name. 

4. In the Condition list, select Starts With. 

5. In the Value field, specify the file name. 

6. Click Start. 
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To remove a filter, click on the cross mark next to it. To remove all configured filters, click Reset. 



 

237 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

Restoring Microsoft OneDrive Data 
Veeam Explorer for Microsoft OneDrive for Business allows you to recover entire users OneDrives or certain 
documents and/or folders of the selected OneDrive. 

To recover your data, do the following: 

1. In the navigation pane, select the object type you want to recover; it can be a folder, a document or 
even the entire OneDrive or all OneDrives belonging to the selected organizations or groups. 

2. On the ribbon menu, or using the corresponding context menu command, click Restore OneDrive (or 
Restore Document/Folder, when restoring documents/folders, and Restore OneDrives when 
restoring all OneDrives for the selected organizations or groups). Then, you can choose between two 
options: Overwrite or Keep.  

Use the Overwrite option to completely overwrite the existing OneDrive data in the production 
environment. If you select Keep, Veeam Explorer for Microsoft OneDrive for Business will preserve 
existing data and recover items with the RESTORED prefix (RESTORED-<file_name>.ext). 

 

3. Specify Office 365 credentials to access your production environment and click Restore. 



 

238 | Veeam Backup for Microsoft Office 365 | User Guide | 2 

 

NOTE: 

if you select Overwrite, Veeam will skip unchanged objects. Such objects will not be recovered. 
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Copying Microsoft OneDrive Data 
With Veeam Explorer for Microsoft OneDrive for Business, you can copy your OneDrive data to the same or 
different user. 

To copy OneDrive data, do the following: 

1. In the navigation pane, or using the preview pane, select an object you want to copy. It can be OneDrive 
itself, a folder, or a document. 

2. On the ribbon menu or using the corresponding context menu, click Copy OneDrive/Copy 
Folder/Copy Document depending on the object type you have selected. 

 

3. Specify Office 365 credentials to access your production environment and click Next. 
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4. Specify whether you want to copy OneDrive data to the original user or to another one and click Next. 
When you select Restore to another one, Veeam will fetch all available users with OneDrives from the 
Office 365 organization and show them in the drop-down list. 

 

5. Select the target location on the destination OneDrive to copy your data and click Next. 
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6. Specify copy options and click Restore. 

The copy options are as follows: 

 Changed items. Allows you to recover data that has been modified in your production 
environment. 

 Missed items. Allows you to recover missed items. 

 Restore shared access. Allows you to recover shared access. 

 History restore options. Allows you to recover particular version: 

o Overwrite. To overwrite data in the production environment by recovering all 
versions from the backup. 

o Merge. To restore only the latest version of the document. 

If not selected all versions in the production environment will be replaced with the 
corresponding data from a backup file. 
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Saving Microsoft OneDrives 
Veeam Explorer for Microsoft OneDrive for Business allows you to save the OneDrives content to the specified 
location. 

To save OneDrives content, do the following: 

1. In the navigation pane, select OneDrive you want to save. You can also select an organization node to 
save all OneDrives in the selected organization. 

2. On the ribbon menu, click Save OneDrives > Save files when saving multiple drives and Save 
OneDrive > Save files when saving s single drive data. You can also click Save as ZIP to save data as 
a ZIP archive with the default compression ratio. 

 

3. Select OneDrives for saving and click Next. 
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4. Specify the directory path to save OneDrive documents and click Finish. 
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Saving Microsoft OneDrive Documents and 
Folders 
Veeam Explorer for Microsoft OneDrive for Business allows you to save your documents and folders located on 
users OneDrives. 

To save a document or a folder, do the following: 

1. Select a folder using the navigation pane, or select a document using the preview pane. 

2. On the ribbon menu or using the corresponding context menu command, click Save Document > Save 
files (or Save Folder > Save files when saving folders). You can also click Save as ZIP to save 
OneDrive documents and/or folders as a ZIP archive with the default compression ratio. 

 

3. Specify the destination folder and click Select Folder. 
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Sending Microsoft OneDrive Documents 
Veeam Explorer for OneDrive for Business allows you to send OneDrive documents to the specified recipients. 
Before sending your documents, ensure that you have configured your SMTP settings properly. For more 
information, see Configuring SMTP Settings. 

To send your OneDrive documents via email, do the following: 

1. In the navigation pane, select OneDrive if you want to send the entire OneDrive. To send a particular 
document or multiple documents, select such documents in the preview pane. 

2. On the ribbon menu or using the corresponding context menu, click Send OneDrive when sending 
OneDrive or Send Document when sending documents. 

 

3. Specify the recipient address and click Send. 
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You can edit the body message by clicking More Details.  

NOTE: 
 The From field will be auto-completed with the e-mail address you have specified during 

configuring SMTP settings. See Configuring SMTP Settings. 
 The maximum amount of data that you would be able to send depends on your SMTP server 

configuration  
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Mail Backup as a Service 
Veeam Backup for Microsoft Office 365 allows service providers to back up tenants hybrid or 
Exchange/SharePoint Online organizations data that may comprise any of the following data types: 

 Microsoft Exchange Organization mailboxes 

 Microsoft SharePoint sites and libraries 

 Microsoft OneDrive documents 

Tenants may utilize the Veeam Explorer for Microsoft Exchange, Veeam Explorer for Microsoft SharePoint or 
Veeam Explorer for Microsoft OneDrive for Business abilities to send self-service recovery requests to the Veeam 
Backup for Microsoft Office 365 service provider server to restore their data. 

To learn more about configuring Mail Backup as a Service for tenants and service providers, see the following 
sections: 

 Configuring Mail Backup as a Service for Service Providers 

 Configuring Mail Backup as a Service for Tenants 

NOTE: 

By default, tenants are not able to restore anything from the backup without the service provider assistance. 
To be able to perform self-service recovery procedures, a service provider must configure authentication 
settings for tenants according to the Configuring Authentication Settings section. 

Performing Restore Operations using RESTful API 
A Service Provider can use Veeam Backup for Office 365 RESTful API to build a web portal that will allow tenants 
to browse and restore their backups without using the Veeam Explorer tool. See the RESTful API reference guide.  

https://helpcenter.veeam.com/docs/vbo365/rest/
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Configuring Mail Backup as a Service for 
Service Providers 
To configure the Veeam Backup for Microsoft Office 365 environment, do the following: 

1. Install Veeam Backup & Replication and Veeam Backup for Microsoft Office 365 version 2.0 on the same 
server. See the Deployment section of this guide and Installing Veeam Backup & Replication to know 
how to install Veeam Backup & Replication. 

2. Install valid Veeam Backup & Replication and Veeam Backup for Microsoft Office 365 licenses. For more 
information, see Licensing for Service Providers section of the Veeam Cloud Connect Administrator Guide 
and the Licensing and License Types section of this guide. 

3. Configure a TLS certificate according to the Managing TLS Certificates section of the Veeam Cloud 
Connect Administrator Guide. Without a certificate, you will not be able to add a Could Gateway 
component. 

4. Configure a Could Gateway according to the Adding Cloud Gateways section of the Veeam Cloud Connect 
Administrator Guide. 

5. Add new tenants according to the Registering Tenant Accounts section of the Veeam Cloud Connect 
Administrator Guide. 

6. Configure your Veeam Backup for Microsoft Office 365 environment according to the Configuring Veeam 
Backup for Microsoft Office 365 section. 

IMPORTANT! 

When planning deployment, remember that Veeam Backup for Microsoft Office 365 and Veeam Backup & 
Replication 9.5 must be installed on the same server. 

https://helpcenter.veeam.com/docs/backup/vsphere/install_vbr.html?ver=95
https://helpcenter.veeam.com/docs/backup/cloud/cloud_connect_sp_license.html?ver=95
https://helpcenter.veeam.com/docs/backup/cloud/cloud_connect_manage_ssl.html?ver=95
https://helpcenter.veeam.com/docs/backup/cloud/cloud_connect_gateways.html?ver=95
https://helpcenter.veeam.com/docs/backup/cloud/cloud_connect_user.html?ver=95
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Configuring Veeam Backup for Microsoft Office 
365 
To back up tenants Microsoft Office 365 organizations data, the service provider should receive the tenant's 
Microsoft organization credentials, to connect to the tenant Office 365 or hybrid organizations. The same 
credentials will be used by tenants to connect to the Veeam Backup for Microsoft Office 365 server when using 
Veeam Explorers for self-service recovery.  

See the following sections to learn more about configuring Veeam Backup for Microsoft Office 365 environment: 

 To learn how to configure overall Veeam Backup for Microsoft Office 365 settings, see the Configuring 
Veeam Backup for Microsoft Office 365 Options section. 

 To learn how to allow tenants to perform self-restore procedures, see the Configuring Authentication 
Settings section. 

 To learn how to configure backup proxy servers, see the Configuring Backup Proxy Servers section. 

 To learn how to configure backup repositories, see the Configuring Backup Repositories section. 

 To learn how to add tenants' organizations to the Veeam Backup for Microsoft Office 365 scope, see 
Adding Microsoft Organizations section. To be able to access tenant organizations, make sure you have 
been provided with the appropriate Microsoft organization credentials from the tenant. 

 To learn how to create a backup of tenants organizations data, see Performing Organization Data 
Backup. 

NOTE: 

It is recommended that you configure dedicated proxies in the Veeam Backup for Microsoft Office 365 
infrastructure. Using the default proxy that is installed along with the Veeam Backup for Microsoft Office 365 
server to process tenant data is not recommended due to a possible high operational load. If you plan to 
perform tenant hybrid organizations backup, you need to obtain tenant on-premises Exchange connection 
settings such as the server name, server ports, and credentials. 
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Configuring Mail Backup as a Service for 
Tenants 
As a tenant you must provide your service provider with your Microsoft organization credentials so that the 
service provider can connect to your organizations and add them to the Veeam Backup for Microsoft Office 365 
service provider scope. You can use the same credentials later when adding a Veeam Backup for Microsoft Office 
365 service provider server to the Veeam Explorer for Microsoft Exchange or Veeam Explorer for Microsoft 
SharePoint scope. See Adding Backups to the Veeam Explorer Scope. 

If you plan to allow your Service Provider to access your environment to perform hybrid organizations backups, 
you should provide your on-premises Exchange/SharePoint connection settings such as the server name, server 
ports, and valid credentials. 

NOTE: 

Tenants are not required to purchase any license to communicate with service providers. With no license 
installed, tenants are still able to add a service provider to their backup infrastructure to get the full range of 
available services. See Adding a Service Provider Without a License. 
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Adding a Service Provider in Veeam Backup & 
Replication 
The procedure of adding service providers is performed by the tenant on the tenant Veeam backup server. To 
use Veeam Cloud Connect resources for data protection and disaster recovery tasks, you must add a service 
provider to Veeam Backup & Replication. 

See the Connecting to Service Providers section of the Veeam Cloud Connect User Guide to know how to add a 
new Service Provider to your environment. 

Adding a Service Provider Without a License 
To switch to the fully functional mode without purchasing any license, do the following: 

1. Go to the main menu > View. 

2. Select Fully Functional. 

 

IMPORTANT! 

If you do not activate the Fully Functional mode, the service provider section in the navigation pane will be 
unavailable. 

https://helpcenter.veeam.com/docs/backup/cloud/cloud_connect_sp.html?ver=95
https://helpcenter.veeam.com/docs/backup/cloud/cloud_connect_user_guide.html?ver=95
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Adding Organization Backups to the Veeam 
Explorer Scope 
To be able to explore your Microsoft Office 365 organizations backups using Veeam Explorers, you should be 
granted access to your service provider Veeam Backup for Microsoft Office 365 server. Access might be granted 
according to the Configuring Authentication Settings section. 

To add a new Microsoft Exchange or Microsoft SharePoint organization database to the corresponding Veeam 
Explorer scope, do the following: 

1. Depending on the data type you want to work with, open the corresponding Veeam Explorer tool. It can 
be Veeam Explorer for Microsoft Exchange, Veeam Explorer for Microsoft SharePoint, or Veeam Explorer 
for Microsoft OneDrive for Business. 

2. Follow the instructions provided the following sections: 

 Adding Organization Backups in Veeam Explorer for Microsoft Exchange 

 Adding Organization Backups in Veeam Explorer for Microsoft SharePoint 

 Adding Organization Backups in Veeam Explorer for Microsoft OneDrive for Business 

After you establish the connection to the Veeam Backup for Microsoft Office 365 server of your service provider, 
you will be able to utilize the corresponding Veeam Explorers abilities. 

 See Processing Microsoft Exchange Backups to learn more about working with Veeam Explorer for 
Microsoft Exchange. 

 See Processing Microsoft SharePoint Backups to learn more about working with Veeam Explorer for 
Microsoft SharePoint. 

 See Processing Microsoft OneDrive Backups to learn more about working with Veeam Explorer for 
Microsoft OneDrive for Business. 
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Exporting Veeam Backup for 
Microsoft Office 365 Log Files 
Log files are used to troubleshoot a variety of different situations when certain processes may have gotten the 
unexpected results while being executed. 

To export logs, do the following: 

1. Go to the main menu and click Options > Help > Support Information. 

2. Select Collect logs. If you want to activate the extended logging mode, select Configure extended 
logging and proceed with the Configuring Extended Logging Mode section. 

 

3. Select components (local or remote) for which you want to obtain log files. 

 

4. Specify the time period for the log export. To export all logs regardless of the time period, select the 
Collect all logs option. 
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5. Specify the path and click Finish. You may leave the file name empty. In this case logs will be exported 
with the default name having the predefined by Veeam format. 
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Configuring Extended Logging Mode 
By default, logs are exported using the default mode. In certain cases, you may need to enable the extended 
logging mode to collect logs that contain more details on specific operations. 

To configure extended logging mode, do the following: 

1. Go to the main menu and click Options > Help > Support Information. 

2. Select Configure extended logging. 

 

3. Select components (local or remote) to which you want to apply the extended logging mode. 

 

After you enable the extended logging mode, you can go back to the application and perform certain actions. 
Then, collect logs as described in the Exporting Veeam Backup for Microsoft Office 365 Log Files section to see 
what has happened during the session. 
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